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Preface 

Introduction 

Welcome to the Hi-Target Hi-Survey Road. This introduction describes how to use this product.  

Experience Requirement 

In order to help you use Hi-Target series’ products better, we suggest you carefully read the 

instructions. If you are unfamiliar with the products, please refer to http://www.hi-target.com.cn/ 

Tips for Safe Use 

 

Notice: The contents here are special operations and need your special 

attention. Please read them carefully. 

 

 

Warning: The contents here are very important. Wrong operation may 

damage the machine, lose data, break the system and endanger your safety. 

Exclusions  

Before using the product, please read these operating instructions carefully: they will help you 

to use it better. Hi-Target Surveying Instrument Co., Ltd assumes no responsibility if you fail to 

operate the product according to the instructions, or operate it wrongly due to misunderstanding 

the instructions. 

Hi-Target is committed to constantly perfecting product functions and performance, improving 

service quality and we reserve the right to change these operating instructions without notice.  

 

 

We have checked the contents of the instructions the software and hardware, without eliminating 

the possibility of error. The pictures in the operating instructions are for reference only. In case 

http://www.hi-target.com.cn/
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of non-conformity with products, the products shall prevail. 

Technology and Service 

If you have any technical issues, please call Hi-Target’s technology department for help. 

Relevant Information 

You can obtain this introduction by: 

1. Purchasing Hi-Target products: you will find this manual in the instrument container to guide 

you on operating the instrument. 

2. Logging onto the Hi-Target official website, downloading the electronic version introduction 

at “Download center” → “Partners” → “Partner center”. 

Advice 

If you have any comments and suggestions for this product, please email info@hi-target.com.cn. 

Your feedback will help us to improve the product and service. 
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Software Introduction 

 

This chapter contains:  

 

■ Introduction 

■ Features 

■ Installation 

■ Quick Start 

■ General Collection 

 
C H A P T E R  
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1.1 Introduction 

Hi-Survey Road is measurement software with a high degree of accuracy on the Android system 

of Hi-Target. 

Hi-Survey Road should be run on Android 2.3.3 or above, it can be run on a Hi-Target 

professional measure controller, a general phone, pad and other Android devices. Just copy the 

Hi-Survey APK to the Android device and install it or do it by third party assistance software. 

1.1.1 Hi-Survey Road 

Hi-Survey Road is designed for road measuring and staking with strong functions; it can be used 

for staking complex roads, combining road lines, and has three road algorithms (intersection, 

element, coordinate): cross sections can be defined easily. The linear element method adopts the 

unified curve element model with rigorous theory, and the numerical integration algorithm is 

used to avoid the higher order errors of traditional algorithms. Generally, the computing result 

can support all kinds of roads, common line and multi-type complex lines and connect receivers 

to measure online via Wi-Fi, Bluetooth and networks. 

1.1.2 Road Function 

- Support for horizontal-section, vertical-section, cross-section, road-staking, slope-staking and 

visual cross-section collection. 

- Calculate line-staking point in real time, support for adding stake over any mileage, mileage-

projecting in real time, and displaying the mileage of staking points. 

- Direct and convenient guidance method of staking, with line-staking and mid-level 

measurements working at the same time. 
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- The horizontal section line supports the common method (intersection, element, coordinate) 

and can freely define the line of any form. For example: interchange ramp. 

- The cross-section earthwork provides two methods: Mean Area method and Prism method to 

calculate the amount of excavation. 

- Supports multiple cross-section grade-change point-setting, the left and right slope can be 

edited into asymmetric type; it can also edit over-elevation and widening of a slope. 

- Supports DTM surface design, DTM surface-staking and DTM earthwork calculation. 

 

1.2 Features 

1. Easy to Use 

- More logical, more convenient, less interface levels than Hi-RTK; 

-Text and Graphic measuring interface in Detail Survey can be chosen by user; 

-Simple design to give a big mapping screen; 

-Station option can be one-key set by configuration file; 

-Defined coordinate system selected by region, convenient to set coordinate parameters; 

-Supports many kinds of angle units, meets the operating habits and demands of business  

customers: good for globalization. 

2. Supports Operating Big Data 

-Supports big raster, vector data in .dxf, .td2, .shp format (geodetic coordinate and plan  

coordinate) 

-Raw data and coordinate data saved independently to make sure the data primitiveness and 

realize post- processing kinematic, it is more flexible in data storing and processing, and the 
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antenna type and height of raw data can be changed, to make sure the data can be recovered (by 

resetting the coordinate parameters, antenna type and height); 

-More complete antenna parameters management. 

3. Fashionable 

-The software and receiver firmware check the updates online automatically; 

- Hi-Target and profession news are real-time pushed; 

-Beautiful and fashionable interface; 

-Wonderful and rich visual and touch experience, help make users enjoy working. 

 

1.3 Installation 

1.3.1 Installation 

Copy the Hi-Survey Road program (.apk) to an Android device, click it to start installing, a Hi-

Survey Road icon will appear on the desktop if installation is successful. The software can be  

installed by third party assistance software. 

 

Figure 1-3-1 Hi-Survey Road 
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1.3.2 Starting Interface 

On first running, it will show the welcome pages listing the software features, slide them to the 

starting interface. The welcome pages will not be displayed after the first starting (view it in the 

About interface). 

There are 4 pages on the main interface: Project, Device, Survey, COGO. (slide or press the Tab 

button to change the page) 

       

Figure 1-3-2 Welcome Page (1)            Figure 1-3-3 Welcome Page (2) 

 

There are 3 main interface themes: List, GridView and Simple: the default setting is GridView. 
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Figure 1-3-4 Device-GridView               Figure 1-3-5 Device-List 

      

Figure 1-3-6 Device-Simple                 Figure 1-3-7 Device-More 
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Figure 1-3-8 Survey-GridView                Figure 1-3-9 Survey-List 

     

Figure 1-3-10 Survey-Simple               Figure 1-3-11 Survey-More 

The module can be added and deleted in simple theme, and can be deleted and recovered in 

gridview and list theme. Long press the module to delete, the module can be recovered in 

Project→Configure→Module Recovery. 
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Figure 1-3-12 Delete             1-3-13 Module Restore              Figure 1-3-14 Select 

Hi-Survey working on the folder ZHD, and the project is saved in folder ZHD/Project/Road. 

 

Figure 1-3-15 Project 

When doing measurements, first create a new project, set the parameters - they are saved in the 

*.prj file; meanwhile, there will be a *.dam file with the same name of the project; the coordinate 

points, stake points, control points will be saved in the map folder. Afterward, create a new 

project (project name is Unnamed), as in the picture follow. 

 

Figure 1-3-16 Road Work File 
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Notice:  

1. If you create a new project when the hand-held does not have an external SD 

card, the project folder will automatically generate a * .bak backup file. 

2. When the handbook has the external SD card, the backup data will be saved in 

the ZHD-Bak folder. The specific project data is stored in the corresponding 

project folder, as in the picture follow. 

 

Figure 1-3-17 Road Backup 

 

1.4 Quick Start 

The following is the software quick start-operation process- refer to the detailed description of 

each chapter for the steps. This process is only a solution that we provide to users; skilled users 

do not need to follow this step. 

1.4.1 Build a Project 

1. Open the Hi-Survey software, the software main interface is as follows: 
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Figure 1-4-1 Main Interface 

2. Create a new project, click Project→Project Info to enter the project name and click OK. 

      

Figure 1-4-2 Project Info                  Figure 1-4-3 New Project 

3. Project Settings: select the projection, set the source ellipsoid and projection parameters. 
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Figure 1-4-4 Project Settings             Figure 1-4-5 Coordinate System 

      

Figure 1-4-6 Projection                        Figure 1-4-7 Datum 

1.4.2 Set the Base 

Connect the device, click Device→Device Connection→Connect to select the base station 

number for Bluetooth pair connection. 
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Figure 1-4-8 Device                        Figure 1-4-9 Connect 

      

Figure 1-4-10 Device Number            Figure 1-4-11 Disconnect 

Set the base station and receiver position, then set the Datalink and Other.  

1. Select antenna type to enter the height and type. 

2. Set the base location. If the base station is located at a known point and know the conversion 



Hi-Survey Road User Manual 

13 

 

parameters, you may not select the smooth, direct input or select the point of the WGS-84 BLH 

coordinates from point library, or open the conversion parameters in advance, enter the local  

NEZ coordinates, so that the base station puts the point of the WGS-84 BLH coordinates as a 

reference and does the transmission of differential data. If the base station is set as unknown, 

click Average  , and click OK after smoothing to complete the coordinates of the base station. 

     

Figure 1-4-12 Set Base                    Figure 1-4-13 Average 

3. Click Data Link, select the data link type and enter the relevant parameters. 

(eg: when you use the Hi-Target server data to transfer operation, you need to set the parameters 

and select the built-in network; where the packet number and group number can be changed, the 

packet number is seven digits, the group number is three digits less than 255. When you use the 

radio station to work, you should select the Internal UHF as the data link, and then select the 

radio channel). 

Radio mode is the traditional data link mode, and the built-in radio mode is taken as an example, 

to illustrate the introduction of radio station mode using simple steps. 
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- Internal UHF: built-in radio 

- Channel: 0 ~ 115 any number, but the mobile station settings should be consistent with the base 

station. 

- Airborne baud rate: 9600/19200 optional, the choice of mobile stations should be consistent 

with the base station 

- Power: High / Middle/ Low 

 

Figure 1-4-14 Data Link 

4. Click Other, select the differential mode, the text format, click Set and it will promptly set up 

successfully. The parameters of the base station must be consistent with the rover station settings.  
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Figure 1-4-15 Other 

5. Check whether the host differential light is flashing once every second (2/sec in power-saving 

mode). When using the external radio station, the radio will flash once every second, if it is 

normal, it will prompt Base station is ready, do you want to set Rover now? 

After the parameter is set, click Set and the host will have a voice prompt, the host light will flash 

twice every second, indicating that the base station is set up successfully and sending the 

differential data. 

Wait until the green light flashes once every second (2/sec in power-saving  mode) and the radio 

red light flashes once every second, indicating that the base station is successfully operating, and 

is transmitting the signal. If the signal does not blink, you can restart the receiver host and re-

operate once again. 

 

 

 

. 
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Figure 1-4-16 Set Prompt 

1.4.3 Set the Rover 

Connect to the rover by Bluetooth, and confirm that the rover data link and other parameters are 

consistent with the base station. The setting of the rover station is the same as that of the base 

station. The data link parameters of the rover station must be the same as the base station, to 

receive differential data. Then click Set and the host will do a voice prompt. Wait until it shows 

Fix Pos, and then start the measurement. 
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  Figure 1-4-17 Set Rover 

1.4.4 Parameter Calculation 

First set the control point library in Point Library→ Control Point to add control points, enter 

the name and the corresponding coordinates by manual input, real-time collecting, point library 

or map selection, and then click OK. 

     

Figure 1-4-18 Point Library   Figure 1-4-19 Control Point   Figure 1-4-20 Edit Point 
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Click Parameter Calculation, select Plane + Height Fitting type and Constant Vertical Offset in 

Height (the Height can be selected as Plane Fitting when there are three points above), and then 

add point pairs, select the point as the source point, enter the corresponding control point 

coordinate in the target point, then click Save. 

     

Figure 1-4-21 Parameters Calculation    Figure 1-4-22 Add Point 

        

Figure 1-4-23 Save Point             Figure 1-4-24 Result 

After adding more than two points, click Calculate, it will show the calculated Plane + Height 

Fitting results, mainly to see the rotation and scale. The result of the plane translation is  
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generally smaller in the north and east, the rotation is about zero, the scale is between 0.9999 

and 1.0000 (in general, the closer to 1, the better the scale is), the smaller the plane and elevation 

residual is, the better the result . Click Apply and the software will automatically use the new 

parameters to update the coordinate point library. 

1.4.5 Detail Survey 

In the Detail Survey interface, start the acquisition coordinates work when the display can be 

fixed. After the rover station on the unknown point is OK, you can press the acquisition key  

and enter the Name, Target H and Target-H type. Then press OK to record the point. 

     

Figure 1-4-25 Detail Survey            Figure 1-4-26 Save Point 

1.4.6 Stake Out 

Click Stake Points to enter the point staking-out interface and click the  button to select the 

staked-out point, then, according to the direction and distance, tips to find the staked-out points. 

There is a process to make the current point (triangle mark) close to the target point (round plus 

cross sign). When the staking-out circle turns red, it is finished and meets the precision 



Software Introduction                                                   

20 

 

parameters. 

In the process of staking-out, you can also collect detail points, by the Store  on the interface 

or store keying on the hand-held. 

   

Figure 1-4-27 Staking Point   Figure 1-4-28 Stake Success 

1.4.7 Data Transfer 

In the Data Transfer interface, select Raw Data, and select the exchange type for export, select 

the corresponding format export or User-defined export, input the file name, select the file save 

the path, and then click OK to export data. If it’s User-defined export, after clicking OK, you can 

enter the custom format settings to select export content, then click OK to export the data. 

    

Figure1-4-29 Data Transfer   Figure 1-4-30 Export   Figure 1-4-31 Custom Format 
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1.4.8 Connect the and-held to Download Data 

Connect the hand-held to the computer with the USB data cable. Click USB Storage in the 

following dialogue box, then click OK in the dialog box when that appears. 

 

Figure 1-4-32 Transfer by USB 

Find the path to export the data file on the hand-held (default: ZHD\Out), copy it to the computer, 

and then the RTK measure is finished. 

 

 

 

 

 

Figure 1-4-33 Exported Data 
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1.5 General Collection 

There are four common ways to get coordinates: Average, Select Point, Select point on map, 

Real-time Collection. 

1.5.1 Average 

Get the coordinate in single status by average, 10 times default, including Average, Weighted 

average, Window average, Median filter. 

       

Figure 1-5-1 Average          Figure 1-5-2 Configure            Figure 1-5-3 Type 

 

 

Notice:  

When using the hand-held for data collection, it supports shortcut key 

operation. The shortcut keys are only supported for detailed survey graphic 

collection. To avoid input conflict, the text interface has no shortcut keys. 

Button 1：  Zoom In     Button 2：  Zoom Out 

Button3：  Zoom center     Button 4：  Zoom All 
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Button5：  Culture Create    Button 6：  Auto Collection 

Button7： Average Survey    Button 8：  Indirect Survey 

Button *：Open the configure    Button Shift：text-map 

 

1.5.2 Select Point in Library 

The NEZ point can be selected in Coord Point, Stake Point, Control Point library. The BLH 

points can be selected in Raw Data and Control Point library 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 1-5-4 Coord Point 
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1.5.3 Select Point on Map 

Click  or  to enter the select point on map mode, click  to select the points in the box. 

Select a number of points with the icon . Click  again to exit the map selection, When the 

icon is on  status, it can select points on screen, click  again to exit choose node on line 

mode, then click OK to complete. 

         

Figure 1-5-5 Select Point      Figure 1-5-6 Map Selected   Figure 1-5-7 Line Selected 
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1.5.4 Real-Time Collecting 

Real-time collecting refers to real-time data acquisition through the receiver equipment. 

 

Figure 1-5-8 Real-time Collecting 

 

Notice:  

1. To carry out real-time collection and support data storage, select Save to point 

library (save to Point Library and Raw Data library), then click OK to collect. 

2. Connect to devices supporting electronic bubble, they will display the 

electronic bubble view in the Device Collection interface, devices that do not 

support the electronic bubble will not display. 
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Project 

 

This chapter contains:  

 

■ Project Info 

■ Project Settings 

■ Coordinate System 

■ Parameters Calculation 

■ Point Library 

■ Raw Data 

■ Mapping Data 

■ Data Transfer 

■ Email 

■ Code List 

■ Software Settings 

■ About 
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2.1 Project Info 

Click Project Info in the main interface to manage the Project. Check the project information, 

including name, points, projection, time, available space and whether to support the collection 

of the same name point and history point. You can make some operations with the project, 

including create, open, delete, recover, export, view, edit, and add attributes. 

     

Figure 2-1-1 Main Interface          Figure 2-1-2 New Project 

- OK: After you input the project name, click OK to get a new project and automatically open it 

for the current project. If there is already a project with the same name, click OK to open it; or 

create a new project as the current project. The old project can be opened or deleted by long 

pressing. 

- Attribute: Save the title and content of the current project. Long press a project to select 

Properties in the toolbar. The attribute length is not limited, nor supported for writing and 

deleting in batches; attribute titles can be the same, when adding attribute names you can enter 

different values; the attribute name cannot be null, it need to be digits, Chinese or English 
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characters. 

       

Figure 2-1-3 Enter Attribute           Figure 2-1-4 Edit                Figure 2-1-5 Add Attribute 

- Delete: Delete the selected project. The project can be deleted directly or backup delete (similar 

to recycle bin), providing the user with a remedial measure after mis-operation. (backup delete 

compresses and then deletes the project). The compressed version is stored at ZHD / Project / 

ROAD directory). 

     

Figure 2-1-6 Delete        Figure 2-1-7 Prompt to Delete 

- Restore: The Raw Data, Coordinate Parameters and Project Info can be restored from the 

ZHD-Bak folder of the external SD card of the work folder. When creating a project or collecting 
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the points, the raw data file, dam or QR code coordinate parameters file, project information file 

and cross-section points library in the same project name folder will be backed up on the external 

SD card ZHD-Bak folder. The Restore function can only be used when installing an external SD 

card. 

     

Figure 2-1-8 Restore List      Figure 2-1-9 Backup Folder 

 

Notice:  

1. If there is no external SD card, it will prompt every time you start the Hi-

Survey. 

2. The backup function requires that the hand-held version must be in V1.0.2 and 

above. 

 

When you restore data, long press the project to select, press the selected project again to cancel. 

Click Select All / Cancel All to select all projects or cancel. After selecting, click Start Restore 

to recover. 
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Figure 2-1-10 Select All or Cancel All 

The recovered project will be saved at Project Info→Previous Projects. If there is a previous 

project with the same name as the restored project, it will add _1 at the end of the recovered 

project name. 

     

 

 

 

 

 

 

Figure 2-1-11 Same Name                  Figure 2-1-12 the Recovered File 
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-Export: Export the current project reports in *.txt format, *.html format of Project Report or 

MappingPoint Report in *.html format. 

     

Figure 2-1-13 Export Format               Figure 2-1-14 Export 
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2.2 Project Settings 

2.2.1 New Project 

 

 

 

 

 

 

 

Figure 2-2-1 New Project 

 

- Auto Enter Project Settings: On opening, it will automatically go to Project Settings, and show 

the System interface to set coordinates. 

- Use Last Localisation Params: After opening, the current project will use the same coordinate 

parameters as the last project (including the transformation model and parameters of plane 

conversion and elevation fitting). 

- Use Last Control Point File: After opening, the control point of the last project will be copied 

to the current project. 

- Define Project Attributes: Set the note of a new project. It will automatically go tothe attribute-

inputting interface to edit the corresponding attribute, after defining the project’s attribute. 

2.2.2 System 

In System interface, coordinate system parameters can be set with the dam file, QR code or in 
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Coord Sys Management. If coordinate parameters are changed, the coordinate point library will 

be updated too. 

Project coordinate parameters include Coordinate System, Framework Shifting, Framework 

Shifting Info, Framework Calibration and Framework Calibration Info. Data Management is 

used for external data management. 

 

 

 

 

 

 

 

 

 

Figure 2-2-2 Load Coord System 

1. Coordinate Parameters - Dam File Loading 

Each software project corresponds to a separate *.dam file, there will be a new Dam file (the 

same name as the project) when you create a project. In Project Settings→System interface, the 

user clicks  to load a dam file, getting the coordinate parameter of the existing project applied 

to the current project: the coordinate point library will be updated at the same time. 
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Figure 2-2-3 Add Dam File 

 

2. Coordinate Parameters - QR Code 

In Project Settings→System interface, click  to enter the QR code scanning interface, to get 

coordinate parameters from the QR code, and then create, Encrypt, share and Save the QR code. 

 

Figure 2-2-4 Scan QR Code 

Click My QR Code and it will create a QR code of the current project coordinate parameters; the 
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user can encrypt, share and save it. The scanned encrypted QR code only can be used, it cannot 

be viewed and edited. 

- Encrypt: The user can choose to encrypt the coordinate parameters first, and then re-generate 

the QR code; the encrypted QR code can be shared and saved; encrypted parameters are not 

visible and cannot be edited, only called. 

- Share: The QR code can be shared by third party software to other customers; 

- Save: The QR code can be saved as a picture in the controller. If there is a file with the same 

name under the save path, you can tick the coverage or enter a new filename. 

 

     

Figure 2-2-5 QR Code              Figure 2-2-6 Encrypt 

     

Figure 2-2-7 Share                  Figure 2-2-8 Save 
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Figure 2-2-9 Prompt          Figure 2-2-10 Projection 

3. Coordinate Parameters - Coord Sys Management 

 

Figure 2-2-11 Coord Sys Management 

The software coordinate transformation module is CoordLib module, which has been verified 

for many years and provides practical and full coordinate calculation ability. In Projection, it 

includes Gaussian, Mercator, Lambert projection, etc. In Datum conversion, it provides Bursa-

Wolf Transformation, Molodensky, Ten Params and others. In Plane conversion, it provides 2D 

Helbert, TGO, Planar Transformation Grid, FreeSurvey and Polynomial Fitting and other 
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conversion methods. In Height Fitting conversion, it provides Mathematical Models, TGO, 

FreeSurvey and Geoid-Ellipsoid Separation Grid. 

In the Project Settings→System interface, users can click  to enter the Coord Sys 

Management interface. Common coordinate systems can be added to system lists for easy use. 

 

     

Figure 2-2-12 Pre-defined List       Figure 2-2-13 Pre-defined Coord  

- Pre-defined: Support for loading the Pre-defined coordinate systems, which are classified by 

continent and country, for convenient selection. 

- User Defined: Add user defined coordinate system according to local situation. 
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Figure 2-2-14 Select Coord           Figure 2-2-15 Apply Coord 

- Delete/Edit: Long press the coordinate system on Pre-defined List to delete and edit. Editing 

coordinate system parameters in the system list do not affect the coordinate system parameters 

in the project, unless you click the Apply button after editing the coordinate system. 

- Apply: Update the projection parameters used by the project. There will pop up a dialog to 

prompt whether the selected coordinate system should be applied to the current project. Click 

OK and the parameters are used successfully. The software converts the WGS84 geodetic 

coordinate BLH, measured by the receiver, to the plane coordinate NEZ of the selected coordinate 

system parameters. 

4. Coordinate System 

Click Coordinate System to go to the Coord Sys Management edit interface; you can edit the 

current project coordinate parameters and the created coordinate system is just used for the 

current project. Whether to update the parameters to the corresponding projection list can be 

chosen when saving. If OK, coordinate system parameters will be applied to the project 

according to current settings; if you select Cancel, coordinate system parameters will not be 
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updated. 

 

Figure 2-2-16 Warning 

 

 

5. Framework Shifting 

This is for computing the horizontal and vertical translation between two coordinate systems.  

The user can transfer the collected GNSS coordinates to local NEZ by one point. For example, 

give the top left point as (0, 0, 0), then other points are translated to an independent coordinate 

system, according to the point.  

Generally, the translation value is too large, if you translate BLH and NEZ, there will be a big 

projection error, so after framework-shifting, the saved BLH is still the original BLH, while the 

NEZ is the local one. 

- Compute: Compute the dN, dE, dZ from the current point and known point. Users need to obtain 

the source point (the current point) coordinates and the coordinates of the known point first. The 

known point can be input directly or selected from the library. The source point can be got from 
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average collection , real-time collection  , library  and map . 

     

Figure 2-2-17 Compute                             Figure 2-2-18 Result 

 

- Apply: Check it to apply the correct value to the project. 

- Load: Load the existing translation file. 

- Save as: Save the translation parameters as a .txt file, so it can be used by other projects. 

- OK: Save the translation parameters and update the project. 

The calculated point translation parameter can be selected in the Project Settings→ System 

interface. 
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Figure 2-2-19 Framework Shifting 

6. Framework Calibration 

This is for computing the horizontal and vertical translation between two coordinate systems, 

generally used for situations as below: 

Only one BJ-54, XIAN-80 point or only one point of a coordinate system which is a little rotated 

from WGS-84. Set the Base, then take the Rover to a known point, click Framework 

Calibration→ Compute, collect the NEZ coordinate, input the known point, click Compute to 

get the Correction dN, dE, dZ of the known point and source point, press Apply to apply the  

 

parameters and the collected points will be corrected to the coordinate system of the known point. 

You created a project, it worked, but you don’t want to set the base at the same place, so now 

you can set the base at any place, by using the Framework Calibration function Open the first-

used project to a known point to correct the coordinates. The correction method is the same as 

the first situation. 

- Compute: Calculate the coordinate correction dN, dE, dZ according to the current point and the 

known point. Users need to obtain the source point (the current point) coordinates and the 
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coordinates of the known point first. The known points can be entered in three ways: select from 

the point library , select from the map , or enter the coordinates directly. Select /

: the resulting known point coordinates will correspond to the NEZ/BLH format. 

         

Figure 2-2-20 Compute    Figure 2-2-21 Correcting Amount   Figure 2-2-22 Current 

- Apply: Apply the calculated correction to the project. 

- OK: Select Apply after computing, and click OK to apply the framework calculation parameters 

(notice: it is different from the OK that appears after pressing the return key). 

 

 

- Cancel/OK: Select Apply, and click the return key to pop up the prompt dialog, click Cancel to 

return the framework calculation parameters; click OK to give up modifying the parameters. 

- Load: Load the stored parameters. 

- Save as: Store the calculated calibration parameters. 

The calculated calibration parameters can be selected in the Project Settings→System interface. 
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Figure 2-2-23 Framework Calibration 

After using the framework calculation parameter to collect points, the parameters are 

automatically recorded in the raw data of each point, so that the geodetic coordinates of WGS-

84 coordinates are restored when errors occur. In the Raw Data→Edit RawData interface, the 

framework calculation parameters of the original data can be viewed. 

7. External Data Management 

Enter External data management, click Add to load layer file *.td2, *.dxf and *.shp (when the 

external data format is incorrect, the file can’t be imported) as the map background. Support  

for arc, circle and spiral curve. The imported dxf can be viewed in map in colours. The colour 

can be switched in Configuration→Display→Display colour. Switch on to display all kinds of 

colours in *.dxf; switch off to display the default black. After loading point, line, polygon in 

*.td2 format, the raster layer is always at the bottom, followed by polygon, line and point. 
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Figure 2-2-24 External Data Management   Figure 2-2-25 External data 

     

Figure 2-2-26 Add External Data   Figure 2-2-27 Edit External Data 
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Notice:  

External data management: opens all layers by default when adding the base 

map. Click the icon in front of the list, to switch layer visibility (on or off), which 

corresponds to that the base map of measurement interface display or not. Long 

press the added layer to open/close/delete the operation. 

 

 

Figure 2-2-28 Display External Data 

2.2.3 Option 

Do some other configurations, including Angle, Distance, Apply Unit to Data Output, Time 

Stamp, Store GNSS Precision and Auto Load Last Road File. 
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Figure 2-2-29 Option 

- Angle: Confirm the angle unit, including DMS, Gons and mil. 

- Distance: Confirm the distance unit, including m, Foot and U.S.Foot. 

- Apply Unit to Data Output: Export data according to the set angle and distance format. 

- Time Stamp: Record the real-time of each collecting point. 

- Store GNSS Precision: Record the precision of each point collection. 

- Auto Load Last Road File: Load the road file used when last opening the project. 
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2.3 Coordinate System 

There are 3 methods to get into the coordinate system setting interface: 

1. Main Interface Project→Coordinate System; 

2. Main Interface Project→Project Settings→System→Coordinate System; 

3. Main Interface Project→Project Settings→System→Coord Sys Management, long press the 

Coordinate system on the list to edit and enter the interface. Click Save after setting all the 

parameters, the system will prompt whether to update the parameters to the corresponding 

projection list, click OK to finish setting parameters. 

         

Figure 2-3-1 System           Figure 2-3-2 Projection            Figure 2-3-3 Height 

 

 

Notice:  

All the tabs in the software can be swiped by gestures, or click the tab page title 

bar to switch the page and make the tab page title bar automatically centred. 
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2.3.1 Projection 

Frequently-used projections built-in: Gauss, Mercator, Lambert, etc. (notice: when using  

Gauss-3 or Gauss-6, the device can automatically compute the origin longitude after  

connecting, other custom projections are not supported). 

 

     

Figure 2-3-4 Obtain Origin Longitude    Figure 2-3-5 Other Parameters 

 

Notice:  

1. Coordinate system-Projection-Zone+ to set whether to add the number. 

2. After opening Zone+, all coordinate E input box will be carried out with the 

number detection, if the number does not match, the input box will display the 

red font indicating that the number does not match the data confirmation.   

 

2.3.2 Datum 

Users can set source ellipsoid, local ellipsoid and datum transfer model (including: Bursa-Wolf 
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Transformation, Molodensky, One-touch, Polynomial Regression and Ten Params). 

\\ 

 

     

Figure 2-3-6 Datum Settings                  Figure 2-3-7 Datum Model 

- Save: Click Save to save the parameters in a .dam file after settings, the set parameters are 

invalid without clicking Save. 

- Source Ellipsoid: Generally using WGS-84, a means semi-major axis, 1/f means the inverse of 

flattening, and there are many frequently-used ellipsoids built-in. 

- Local Ellipsoid: Local used ellipsoid. 

 

Notice:  

Customize the ellipsoid:  

Edit the name of the source ellipsoid or target ellipsoid, long axis a (m) and the 

inverse of flattening (1/f) into the two lines to be input, the user input, the 

corresponding parameters and save it. Then the custom ellipsoid parameters will 

be saved in the file ZHD / Ellipse.csv 
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. 

 

     

Figure 2-3-8 Datum-Source Ellipsoid    Figure 2-3-9 Datum-Local Ellipsoid 

1. Bursa-Wolf 

Including translation, rotation, scale parameters between two ellipsoids, the rotating angle should 

be very small. Bursa-Wolf needs at least three points to compute, it’s suitable for conversion 

between different ellipsoidal coordinates. 

2. Molodensky 

A simplified mode of Bursa-Wolf, only space translation parameters, it is a low accuracy mode 

and just needs one point to compute: suitable for the transformation of  WGS-84 to a national 

coordinate system. 

3. Polynomial Regression 

Express the transfer relations of each space vector between two ellipsoids by a polynomial. 
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2.3.3 Plan 

Include 2D Helmert, TGO, Planar Transformation Grid, FreeSurvey and Polynomial Fitting. 

 

Figure 2-3-10 Plan Method 

1. 2D Helmert 

Includes translation, rotation, scale parameters between two plane coordinate systems, it just 

needs two points in any coordinate system to compute. 

 

Figure 2-3-11 Plan Configure 

2. TGO 
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A plane coordinate system transfer method of TGO software, more North Origin, East Origin 

than 2D Helmert. 

3. Planar Transformation Grid 

Select existing grid file to transfer WGS-84 to grid coordinate. The grid file (*.grd) needs to be 

copied to the GeoPath folder in ZHD. 

4. FreeSurvey 

A transfer method of THALES company, more North Origin, East Origin than 2D Helmert. 

5. Polynomial Fitting 

Transfer the place by a polynomial model. In some projects, when the known points involved in 

calculating plane transformation and elevation fitting parameters are different points,  use 2D 

Helmert and Height Fitting to individually calculate parameters. 

The 2D Helmert is used in the calculation part of the plane, and the method is similar to the 

datum conversion model. 

- When using four-parameters, the scale parameter is generally very close to 1, about 1.0000x or 

0.9999x. 

- When using three-parameters, the parameters generally need to be less than 120. 

- When using seven-parameters, the parameters are required to be smaller, preferably less than 

1000. 
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2.3.4 Height 

Include Mathematical Models, TGO, Geoid-Ellipsoid Separation Grid and FreeSurvey. 

1. Mathematical Models 

- Constant Vertical Offset: Translation needs one starting point at least.  

- Planar Fitting: Needs three starting points at least. 

- Quadratic Surface: Needs six starting points at least. 

- Zonal: Needs three starting points at least. 

2. TGO 

A height transfer model includes five parameters: H0 (constant adjustment), Kb (north slope), 

Kl (east slope), North Origin and East Origin. 

3. Geoid-Ellipsoid Separation Grid 

Select existing grid file to fit height. The grid file (*.grd) needs to be copied to the GeoPath 

folder in ZHD path. 

4. FreeSurvey 

A transfer method includes five parameters: H0 (constant), Kb (north slope), Kl (east slope), B0 

(origin latitude) and L0 (origin longitude).  
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Figure 2-3-12 Height         Figure 2-3-13 Parameters          Figure 2-3-14 Result 

The calculation of the individual height-fitting parameters includes Constant Vertical Offset, 

Planar Fitting, Quadratic Surface, and Zonal, which correspondingly require one, three, six and 

three starting points, at least, to be used. Enter the Name, N, E, the original H and the target H of 

the point involved in the height fitting parameters calculation, then click Add. After adding all 

points, click Compute to see the residual values, the maximum residual value is generally 

required to be less than 3 cm. If the value meets the requirements, click Apply. If not, click Cancel, 

remove the points with a big error and have a re-solution.  

Set the height fitting mode: 

- Constant Vertical Offset refers to the receiver measured height plus a fixed constant as the use 

of elevation: the constant can be negative. 

- Planar Fitting refers to the height anomaly corresponding to multiple levelling points to 

produce an optimal fitting plane. When the plane is parallel to the horizontal plane, the planar 

fitting is equal to the constant vertical offset. 

- Quadratic Surface refers to the height anomaly corresponding to multiple levelling points to 

produce an optimal fitting paraboloid. Quadratic Surface is relatively high for the starting data, 

and if the fitting is too poor, it may cause a height correction value divergence in the work area. 
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- Zonal: two known benchmarks to create a virtual mark, used to make the planar fitting. 

- Grid Fitting needs to select the grid fitting file, it supports Trimble (ggf), HI-Target (zgf), 

Geoid99 (bin) formats, compatible with egm-96 model. Grid fitting files are often large, the 

reading may take some time, please be patient. Grid Fitting is rarely used. If Grid Fitting and 

the other four kinds of elevation method are selected at the same time, Grid Fitting will be taken 

first, and then the hother fittings. 

 

Figure 2-3-15 Height Fitting Plane Simulation 

Notice: When importing parameters from the computer, the parameters can be edited into * .txt, 

parameter formats are as follows: 
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Table 2-3-1 Built-in Network Parameter Settings 

Four-parameters Seven-parameters 

// The first line is skipped and just written 

DX:9847.12172733449 

DY:-200265.017483647 

R:0.0162640727776042 

m:0.000162436743812444 

// The first line is skipped and just written 

DX:511.755584317388 

DY:-674.430387295999 

DZ:-656.294939762613 

RX:-0.000126577363609681 

RY:-1.44916763174951E-05 

RZ:0.0261524898234588 

m:0.000168070284370492 

 

2.3.5 Plane Grid 

Open the Grid needed and select the grid file. The grid file (*.grd) needs to be copied to the 

GeoPath folder in ZHD. 

    

Figure 2-3-16 Plane Grid    Figure 2-3-17 Grid-Grid File 
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2.3.6 Option 

To apply the parameters computed by HD-Power to Hi-Survey Road, just input the parameters, 

select Simplified in Helmert Formula and the first in 2nd Eccentricity Formula. 

- ncrypt: To display the file encryption, the settings cannot be changed; if the dam parameter file 

is encrypted, you can see if the coordinate system date is expired. 

- Plane Correction Grid: Bilinear Interpolation/Dual-quadratic Spline Interpolation. The 

default is dual-quadratic spline interpolation. 

- Plane Correction Grid: It is hidden by default, and it can be seen only if the model in the Plane 

interface is either Planar Transformation Grid, or the NE Grid or NEZ Grid in Plane Grid 

interface is opened.  

After modifying the values above, click Save, the software will modify the dam file under the 

current project, with the same name as the project; if the reference ellipsoid has been transformed, 

the coordinates will change. 

    

Figure 2-3-18 Option         Figure 2-3-19 Plane Correction Grid 
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2.4 Parameters Calculation 

This function is for computing the transfer relation between two coordinate systems, including 

Bursa-wolf Transformation, Modensky, Plane + Height Fitting, 2D Helmert Transformation, 

Height Fitting and One Touch. 

     

Figure 2-4-1 Parameters Calculation        Figure 2-4-2 Add Point 

- Add: Add the source point and local point; the source point can be input from manual, real-time 

collecting, library and selecting on map (BLH by default), the local point can be input from 

manual and library. Single or average collection is used for parameter calculation and data 

storage is supported (save to the Coord Point & Raw Data). After input, click Save. If you need 

to manipulate the existing point information, long press it to edit or delete. 

 

 

 



Hi-Survey Road User Manual 

59 

 

 

 

 

Figure 2-4-3 Save to the Point Library 

- Open: Support for Point pairs (*.txt), Carlson Loc File (*.loc), User-defined (*.txt). 

- Save: Save the point pairs coordinate information, support for Point pairs (*.txt) and User-

defined (*.txt). The angle format and exported file can be set in User-defined (*.txt) 

- Compute: Compute the transfer parameters from source point to local point, it will compute the 

parameters and HRMS, VRMS of each point (HRMS: the horizontal RMS of the current point; 

VRMS: the vertical RMS of the current point). 

  

 

 

 

 

 

Figure 2-4-4 HRMS and VRMS 
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- Apply: Apply to corresponding coordinate parameters, and the result will be updated to Coord 

point library. 

- Cancel: Cancel the parameters computing result and go back to calculation interface. 

     

Figure 2-4-5 Edit Point                       Figure 2-4-6 Result 

     

Figure 2-4-7 Plan + Height Fitting                Figure 2-4-8 Add Point 
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The coordinate information input of point pairs by Plane + Height Fitting calculation can be set 

with specific types: 

- Tick Plane: Use the plane coordinate NE of the point. 

- Tick Height: Use the elevation coordinate Z of the point. 

- Tick Plane & Height: Use the plane coordinate NE and elevation coordinate Z of the point, to 

compute plane and height fitting. 

The colour description of point pairs in Plane + Height Fitting: 

- Blue: Use plane coordinate information of point pairs only. 

- Yellow: Use elevation coordinate information of point pairs only. 

- Green: Use plane and elevation coordinate information of point pairs. 

 

Notice: 1. From the Project Settings→System→Coord Sys Management, enter 

the Edit or Define Project Attributes coordinate parameter interface to do the 

parameter calculation, which is the calculation for parameters’ conversion 

corresponding to current custom or edited coordinate system type (you can’t 

change the parameter calculation type); 

2. From the Project→Parameter calculation or Project→Coordinate system 

→Parameter calculation or Project→Project Setting→System→Parameter 

calculation - to calculate the current project coordinate conversion parameters. 

The parameters’ calculation type can be selected independently, and the default 

is the Plane + Height Fitting. Height-fitting type is the current selected type for 

parameter fitting by default. 

 

 



Project 

62 

 

2.5 Point Library 

All coordinate point, stake point, control point data will be saved here, including Name, N, E, Z, 

and Description. The list can be viewed by left and right slipping. You can search and add points, 

or change the display settings. Long press to enter select mode, tick  to select all/ cancel all; 

the selected points can be deleted or edited, you can delete many points, but only  edit one point. 

       

Figure 2-5-1 Coord Point       Figure 2-5-2 Stake Point    Figure 2-5-3 Control Point 

 

Notice:  

1. In the Coord Point and Raw Data, the coordinate point list is a positive 

sequence display, the latest collection points shown in the last. 

2. Coord Point - only for viewing, showing and editing the description, it does 

not allow add or delete. 

 

- Search: Search the corresponding point by name and description. 

- Set: Set the NEZ display order of the coordinate points, the decimal number of the coordinates, 

and the number of coordinate points. 
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Figure 2-5-4 Display Settings 

- New: Create the new stakeout document at the same project. Click Stake Point, the current list 

will be cleared, at the same time, the file system will be in a fixed file directory (map folder 

under project) new a blank Stake Point as the current staking points file. 

- Open: Open other stakeout documents at the same project; if you need to open the A project 

stakeout point, you must first copy the *.td2 and *.tdb file of A to the same project directory. 

- Batch: Support to add numerous stake and control points from the point library. 

- Add: Add coord point information, including name, coordinate and description; the coordinate 

can be from real-time collection , select point  and select on map . 

- Edit: Only edits description of coord points. All data of stake point and control point can be 

edited. 
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Figure 2-5-5 Coord Point     Figure 2-5-6 Stake Point       Figure 2-5-7 Control Point 

 

Notice:  

1.Point Library of Edit operation does not allow editing the name and 

coordinates, it can only edit description. 

2. Edit operation can only choose one edit at a time. 

- Delete: Delete the selected stake point and control point; points can be deleted en asse, or tick 

 in front of a name to select all to delete. Point Library cannot be deleted. If you need to delete 

the coordinates, go to Raw Data interface for deletion. 

     

Figure 2-5-8 Delete            Figure 2-5-9 Delete All 
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Notice:  

1. The Stake Point and control point support full / full cancel. The Point Library 

does not support this operation. 

2. Long press to enter the selection mode, click to select multiple points, check the 

 button to select the all / cancel all operation; you can delete one or more selected 

points, but each time only one point to edit. 

 

2.6 Raw Data 

Raw Data is to record BLH, Target H RMSE and description under WGS-84 ellipsoid collection, 

it can be transferred to get plane coordinates by using the coordinate transfer system. 

     

Figure 2-6-1 Raw Data                Figure 2-6-2 Select Raw Data 

 

 



Project 

66 

 

- New: Create a raw data file (*.raw). 

- Open: Open an existing raw data file. 

- Search: Search the coordinate point by name or description. 

- Edit: Edit the raw data point name, code, station, target height, height type and antenna type; it 

supports batch edit; the corresponding coordinate point name will be changed after editing raw 

data. 

View other information of point, including solution type, coordinate information, number of 

average, difference ages, PDOP, satellite, the recording time, station coordinates, the vertical 

Angle, azimuth of tilt vector and points calibration information, etc. 

 

Notice: 1. Raw Data list shows the ground point of the earth coordinates B, L, H 

(consider Framework Calibration, the Antenna high), slide to right to view the 

original data list. 

2. All the geodetic coordinates shown in measurement interfaces are geodetic 

coordinates of ground points. 

 

     

Figure 2-6-3 Edit RawData          Figure 2-6-4 Batch 
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Notice:  

1. Turn on Surveying Configure → Data → Allow Same PtName function, raw 

data supports the same name point collection. If you close it, the name of the re-

entry will be prompted to repeat that Duplicate name: please enter it again. 

2. In the Edit RawData→Other Info can check Framework Calibration 

information. If the project does not open using the Framework Calibration, the 

Framework Calibration value is 0. 

- Upload: Upload raw data to the private cloud. 

- Set: Set the loading sequence and display. 

- Process: Apply the current parameters to point library and get the result. Tick Use coordinate 

system of current project, the project coord system is used by default, do not tick Use coordinate 

system of current project if you need to update the coordinate system, just go to Coord Sys 

Management to set it.  

 

Notice:  

Data after the handle will update the coordinate point library by default, the 

measurement interface will display the new point coordinates after opening the 

new coordinates system. 
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Figure 2-6-5 Raw Data            Figure 2-6-6 Process 

     

Figure 2-6-7 Export              Figure 2-6-8 Custom Format 

Processed data can be exported and export content can be selected in the optional field of the 

custom format setting. If there is the same file name, then it will prompt “the same file name 

already exists’, you can check to Cover the original data or enter a new file name, then click OK 

to export. 

Optional fields include: id, Name, N, E, Z, B, L, H, Tilt N, Tilt E, Tilt Z, Tilt B, Tilt L, Tilt H, 
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Antenna H, σN, σE, Plane HRMS, σZ, Target H, Ave Times, Status, StartLocal time, EndLocal 

time, StartUTC time, EndUTC time, Desc, Latency, Sats, Shared Sats, PDOP, Elevation(°), VRS 

Name, Base B, Base L, Base H, Station, Tilt Angel, Tilt Azi, Tilt X, Tilt Y, TiltX Azi, Local B, 

Local L, Local H, Baseline Length, Azimuth, Offset, Audios, Images and Null. 

 

2.7 Mapping Data 

Mapping Data can show all mapping survey points and supports New, Open, search, and long 

pressing to delete and edit. 

     

Figure 2-7-1 Mapping Data                Figure 2-7-2 Edit Mapping Data 

2.8 Data Transfer 

Export or import Raw Data, Stake Point, Control Point and Mapping Data of the current project, 
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for convenient searching and using. If there is a file with the same name as the exporting one, it 

will show A file with the same name already exists, tick Cover to export it - this does not delete 

the old one. 

 

Figure 2-8-1 Export 

Raw data export format includes: 

User-defined(*.txt), User-defined(*.csv), dxf File(*.dxf), shp File(*.shp), Excel File(*.csv), 

South cass7.0(*.dat), Scsg2000(*.dat), PREGEO(*.dat), asc File(*.asc), kml(*.kml), NETCAD 

(*.NCN). 
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Figure 2-8-2 Format-CSV           Figure 2-8-3 Format List 

Coordinate point, stake point and control point are saved as Survey.td2, Stake.td2, Control.td2 

in the Map folder. 

Raw data supports importing from Hi-RTK, which realises the data compatibility between Hi-

RTK and Hi-Survey Road. The raw data, stake point and control point support user-defined 

importing. 

The import and export operation of custom format file method is: 

     

Figure 2-8-4 Import                  Figure 2-8-5 Fields 
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1. In the Supported Fields list, select the fields that need to be exported. The Selected Fields are 

automatically filled in the Selected Fields list click the button  to select the full or full 

cancellation fields. The Export Contents will show the heads of the parts in proper order; 

2. Select one item of Selected Field, clicking Delete will not export the field. If you move Up or 

Down to adjust the export order, the Export Contents field order will change all together; 

3. Click the Set button to set the Angle format, Precision, Splitter and whether to include the 

Format Header and Template Management, etc; 

 

Figure 2-8-6 Custom Format 

4. After setting, click OK to import or export the file; when the software is reintroduced into the 

staking point interface, the import format will default to be the data format of the last import, as 

long as the user does not do data cleaning or uninstall the software. 

5. Project tilt measurement, Data Transfer→Raw Data custom export, supports the export of 

non-tilt correction of the plane coordinates. 

6. If the item PPK function is ticked, when the mobile station is set, the PPK correction prompt  
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box will pop up when the original data is exported in Raw Data→Data Processing or Data 

Exchange. Click Yes to enter the PPK correction file selection box, then select the file to correct 

the processing or exported point. 

     

Figure 2-8-7 Prompt PPK           Figure 2-8-8 Select PPK File 

                         Notice:  

1. All the import and export methods involved in the file custom format are the 

same with this step. 

2. The file import data needs to do the number and coordinate range detection 

(including parameter Calculation Loading, Data Exchange - Stake Point / 

Control Point import, Stake Line→Stake Line Library loading, Road 

Stake/Cross-section Collection→Road Design File the choice of loading, Road 

Design →Plane-Section Design Line intersection, line element, coordinate 

method of loading. If the test data is not within the range of the value, or the E 

coordinate band number does not match, the Input import error prompt box is 

displayed. 
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2.9 Email 

As an Android email client, the user can send project files by email to realize for remote 

uploading of data. 

 

Figure 2-9-1 Email- From Hi-Survey 

Tick From Hi-Survey to let Hi-Target send  mail as the sender.  

Otherwise , users can switch to the mail type and enter the address, it supports most email 

systems. 

 

 

 

 

 

 

Figure 2-9-2 Email-Enter Address 
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Tick Feedback to give the feedback to Hi-Target - the default address is Hi-Target enterprise 

mail. 

 

Figure 2-9-3 Feedback 

File browser operation method (all operations involved in the file browsing options are 

applicable to this method in this software): 

1. Press and hold an item; when the bottom right corner of the current item  appears, put all  

 

items into selection mode, press the BACK button to exit the selection mode; 

2. In the selection mode, you can select or deselect, or select multiple options; 

3. In non-selection mode, click  on each page, to return to the upper directory, until you reach 

the root directory of sdcard; 

4. Click OK to complete the file selection; 
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Figure 2-9-4 File Manager 

File transfer network status test; enter the file transfer interface initially, without displaying the 

network status test button. When clicking Send and the message fails to send, it  will show the 

Test Network button; click it to Test Network status, and display the test results. 

 

Figure 2-9-5 Check the Network 
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2.10 Code List 

Code List is to replace the long description with a short code. The user can enter Code List from 

the main interface, to Add, Search, Edit and Delete the code, and the code is synchronised with 

the property.txt or property_zh.txt. 

 

Figure 2-10-1 Code List 

 

- Add: Users click Add to switch to the add page, user input code and descriptions; click OK to 

store the code, the software will update the Code List. 

 

Figure 2-10-2 Add Code 
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- Search: Users can click Search to switch to the search page, or the user input code; click OK, 

and the software will retrieve a match, switch to Code List showing the matched code. If no 

results appear, the search page is stopped. 

    

  Figure 2-10-3 Search        Figure 2-10-4 Search Result 

- Edit: Long press the specific code, click Edit to switch to the edit page, click OK to store the 

code; the software will switch to Code List to update the list (NB no support for batch editing). 

 

- Delete: Long press the specific code, click Delete to delete the selected code ( batch editing 

supported). 

        

Figure 2-10-5 Select Code      Figure 2-10-6 Edit Code    Figure 2-10-7 Delete Code 
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2.11 Software Settings 

    

 Figure 2-11-1 Software Settings (1)   Figure 2-11-2 Software Settings (2) 

 

- Auto Connect Device: Once opened, it will auto prompt whether to connect to last device 

automatically when in the connecting, station setting and survey interface. 

- Check Correction Transmitting: Once opened, it will check difference sending status in Base 

model and check difference receiving status in Rover model, and will show it in a floating 

window. : close check correction transmitting; : send no difference message; : 

sending difference message. When in the handle difference mode, there is difference detection 

function, so there is no Check Correction Transmitting option. 

- Check Network Status: Once opened, it can detect the network status of the host, or support 

iRTK5 series host. In the built-in network mode, open the software Settings → Check Network 

Status switch and open the floating window to view the current network signal strength directly. 

- Check Base Position: Once opened, when rover is first getting the difference, if the Base 

position is different from before, it will prompt whether to calculate a point. During operation, 
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if a base station change is detected, it will prompt the user base station location to change, and 

the user can judge the problem according to the actual situation. 

- Keep Screen Light On: The shutdown status indicates that the power-saving  mode is selected 

and the screen is not in light status. 

- Soft Input: You can use soft input (screen input method) if opened; if closed, only via the 

keyboard. 

- Floating Window: The floating window is set to display in the non-survey interface. The fixed 

position of floating window in the survey interface shows no shrinkage; when in  non-survey 

interface, you can hold the floating window and drag it to any position in the screen, after 5 

seconds, it automatically shrinks 

 

    

Figure 2-11-3 Floating Window        2-11-4 Floating Window Display 

 

Figure 2-11-5 Floating Window 

 

○1  

○2  

○3  

○4  

○1  Public satellites & Visible satellites ○2  PDOP 

○3  Solution state ○4  Differential age 
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- Public satellites: There is no public satellite in Base station, only when rover station receives 

the difference data. Public satellites refer to the calculated used satellites, when the base and 

rover station participate in whole cycles and search at the same time, generally it needs more 

than 5 to work properly. 

- Visible satellites: The number of satellites received by the receiver, and 5 at least in RTK works. 

- PDOP: The spatial geometrical intensity factor of satellite distribution; the better the satellite  

distribution, the smaller the PDOP value; generally, less than 3 is the ideal state. 

- Solution state: mainly includes the following modes (except for the fixed coordinates, the 

precision ranges from high to low): the known points refer to the fixed (base station) → Fix 

Pos   → RTK Fix  → Float  → DGPS  → SDGPS → Auto →None (no GNSS Data). 

- Differential Age: Refers to the time when a rover station receives a base station signal for 

solution. 

Description of working mode mark of the Floating Window: 

 Rover Station (close Check Correction Transmitting) 

 Rover Station (send no difference)    Rover Station (sending difference) 

 Base Station (close check correction transmitting)  Base Station (send no difference)      

 Base Station (sending difference)     Built-in GPS      Demo Mode    

 No Connection    Unknown Device   Static Mode 

Description of Floating Window data link: 

No data link         With data link    Built-in network 

External network (3G) Built-in radio     External radio 
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Handle difference (sending difference)      Handle difference (no difference) 

Handle difference (non-normal difference)    WIFI data link 

When the data link is handle difference, click  on the floating window to enter the Data 

Collector Internet Status interface and check the network status. Click Connect server to achieve 

the handle difference forwarding; if the user has connected to the receiver for the rover station 

difference, click Disconnect server to stop forwarding difference. 

    

   Figure 2-11-6 Connect        Figure 2-11-7 Disconnect 

- Time Zone: Select work time zone, correct the UTC time input by GNSS receiver to the local 

time in the user’s area. 

 

Notice:  

For the iRTK5 host, after the time zone is selected, the handle is connected to the 

receiver, and the software pops up the waiting box to set the receiver time zone. 

The handle sets the time zone of the receiver each time the device is connected. 

After the software has set the time zone, the host needs to be restarted, which can 

be verified by static file creation time. 
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- Theme: Three themes, including List, Style Box and Simple. 

 

       

Figure 2-11-8 Simple            Figure 2-11-9 Gridview              Figure 2-11-10 List 

- Screen Orientation: Can be either landscape or portrait. (the function applies to QpadX5). 

- Module Restore: Long press to delete module, press return key to exit delete mode, software 

settings module cannot be deleted. After deletion, module recovery can restore the deleted 

module to its original location. 

- User Guide: The user guide can be viewed through a third-party PDF reader. When viewing 

the user guide, you need to have a PDF document in the ZHD directory, or the handle on the 

Internet, and a PDF reader installed. 

2.11.1 Location Information 

Click position icon on the floating window to quickly view the location details. 

 

Figure 2-11-11 Floating Window - Location Information 
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Display the location information of the current point, including NEZ, Velocity, solution state,  

 

Local time, and so on. 

    

  Figure 2-11-12 Location Info   Figure 2-11-13 Base Station 

- Reset RTK: Rover station will calculate the received difference from base station again, usually 

under the condition of poor satellite status, you can calculate it many times, save the coordinates, 

to rule out an incorrect solution with multipath interference. 

- Enable internet connection: Check whether the network is disconnected; after connecting, it is 

convenient to direct reconnect. 

- Disable internet connection: Disconnect the network after connecting. 

- Clear Ephemeris: When the rover station is out of lock, floating and unable to achieve the fixed 

location, and cannot find Beidou or GLONASS, then click the Clear the ephemeris button. Reset 

the main board after clearing. 

- Base Station Information: Display base station coordinates, distance, horizontal distance and 

azimuth。 

 

 
 
 
 
 

2.11.2 Satellite Information 
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Click satellite icon on the floating window to quickly view the satellite details. 

 

Figure 2-11-14 Floating Window-Satellite Information 

1. SATView 

View the projected location of the satellite, the national flags represent their satellites, and the 

corresponding number below each satellite is the number of the locked satellites. 

- GPS: The Prn range is 1-33 

- GLONASS: The Prn range is 65-96 

- SBAS: The Prn range is 120-151(EGNOS: Prm values: 120,124,126; SDCM: Prm values: 

125,140,141; GAGAN: Prm values: 127,128; MSAS: Prm values: 129,137; WAAS: Prm values: 

133,135,138) 

- BDS: The Prn range is 161-195 

- GALILEO: The Prn range is E1-E52 

- QZSS: The Prn range is J191-J195 

View and set GNSS satellite elevation mask, click Set to set the elevation mask. 
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Figure 2-11-15 SATView 

Set the colour according to the L1 carrier signal-to-noise ratio of satellite, colour: red <= 31, 31 

< orange <=41, green >41. 

 

Figure 2-11-16 Status 

2. Satellite Signal-To-Noise Ratio Map 

PRN is satellite number, Azi is the azimuth of satellite, Ele is the elevation mask, L1 is the signal-

to-noise ratio of L1 band, L2 is the signal-to-noise ratio of L2 band, and Type is the satellite type. 
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Figure 2-11-17 SAT Info 

 

2.12 About 

Here are the related instructions for the software version and upgrade. 

Open the application in the networked state, and when a new version of the software is detected, 

the system will display the popup, according to the configuration information on the server. If 

the current link is a non-WIFI data link, the user will be prompted whether to download. 
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Figure 2-12-1 Update        Figure 2-12-2 QR Code 

The interface added the QR code of Hi-Target Facebook and Youtube, which can be accessed 

by scanning. 

 

Notice:  

The information above is virtual information, the factual operations are based on 

actual information. 
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Device 

 

This chapter contains:  

 

■ Device 

■ Base 

■ Rover 

■ GNSS Demo Mode 

■ Controller 

■ Additional Settings 

■ Console 

■ Static 

■ RangeFinder 
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3.1 Device 

3.1.1 Device Connection 

To connect the hand-held controller to GNSS receivers set the device connection method and 

antenna type (can be modified after connection), and then click Connect. 

    

Figure 3-1-1 Device                  Figure 3-1-2 Bluetooth Connect 

There are three methods of connection, Bluetooth, network and Wi-Fi. In addition, the built-in 

GPS and demo modes can be set independently with the hand-held controller. 

1. In Bluetooth connection mode, it’s necessary to turn on the Bluetooth function of the receiver 

and hand-held controller at the same time, and click Connect to enter the Bluetooth connection 

interface. Click Search device to search for the device that needs to be connected, choose it in 

the list by the S/N and there will be a Bluetooth pairing prompt. Enter the pairing password 

(default password is 1234) to connect the device, and paired devices do not need to enter the 

pairing password again. If no device is found, please click Search device to search  
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again. 

2. In Network connection mode, click Connect to enter the network settings interface, and set the 

ID and password to connect the device (NB only supported on specific models). If it’s the first 

time of connnection, please connect the receiver by Bluetooth first. Set the IP and port in 

Additional Settings→Receiver Settings→Remote Connection, then use the network connection 

to do wireless remote operation easily. 

 

Figure 3-1-3 Network 

2. In Wi-Fi connection mode, if there is no Wi-Fi connected to the current hand-held controller, 

it will automatically enter the system Wi-Fi connection interface. Please choose the Wi-Fi that 

is needed, then click Connect. If there is already Wi-Fi connected, users can choose Cancel, 

Other or OK, according to the situation. 
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Figure 3-1-4 Wi-Fi                             Figure 3-1-5 Wi-Fi Prompt 

4. In Built-in GPS connection mode, it will display the S/N of the hand-held controller, when 

using the Hi-Target hand-held controller, otherwise it will be blank. In working mode, receiver 

FW and expiration will be blank too. 

 

Figure 3-1-6 Built-in GPS 



Hi-Survey Road User Manual 

93 

 

 

5. In Demo connection mode, the working mode, receiver FW and expiration will be blank too. 

S/N will display as demo mode. 

    

Figure 3-1-7 Demo Mode               Figure 3-1-8 Mode Prompt 

The current receiver's connection status will be displayed after the device is connected 

successfully, including the S/N, Check Update, Working Mode, Receiver FW, Expiration, 

Method and Antenna. 

 

Figure 3-1-9 Device Info 
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- Check Update: Check and upgrade the connected host and motherboard firmware. After 

connecting the receiver by Bluetooth or Wi-Fi, click Check update to enter the firmware update 

interface. If there is new firmware, there will be a prompt, and users can click Update button to 

upgrade. 

 

Figure 3-1-10 Firmware Update 

- Working Mode: Display the current receiver's operating status, generally base mode, rover 

mode or static mode. 

- Receiver FW: Receiver firmware version number and receiver type. 

- Expiration: Deadline for registration code use. 

- Antenna: Set the antenna type. Enter the antenna manage interface to choose it, according to 

the model; if there is no matching antenna type, you can click Add to add the custom antenna 

type by inputting the Model, Desc, Radius, L1 Phase Offset, L2 Phase Offset and SHMP Offset 

in the Add Antenna interface. 
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Figure 3-1-11 Antenna Manage      Figure 3-1-12 Add Antenna 

3.1.2 Register 

Registering the receiver. Connect the GNSS receiver, input the receiver registration code, or scan 

the receiver QR code to register (please ask the Hi-Target service person for the registration code 

or QR code). The code for the 7-digit S/N receiver is 21-digits, with a 24-digit code for the 8-

digit S/N receiver. 

 

Figure 3-1-13 Register 
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3.1.3 NFC Connection 

Users can scan the NFC-enabled receiver's NFC tag, with the NFC-enabled hand-held controller, 

to connect the device. 

The current receiver's connection status will be displayed after the device is connected 

successfully, including Working Mode, Receiver FW, Expiration, Method, Antenna, etc. 

 

3.2 Base 

The base settings mainly set the working parameters of the base station, including the base 

coordinates, data link and other parameters. 

3.2.1 Base Configuration 

Users can save all the parameters, set in the base station, as a configuration file, or load the 

parameters directly from the configuration file. 

    

Figure 3-2-1 Configure     Figure 3-2-2 Delete or Load 

 

- Save: Input the configuration name and click to save the current set parameters. 
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- Delete: Delete the selected configuration file. 

- Load: Load parameters of the selected configuration file. 

- : Generate the parameters of the current settings as a QR code. 

3.2.2 Receiver Position 

Set the coordinates of the base station to the latitude and longitude coordinates in the WGS-84 

coordinate system (requires the GNSS to be measurable to get the height anomalous value, 

because the H of the base position is the ellipsoid height and the motherboard needs the 

geoidal height of the internal model). 

 

Figure 3-2-3 Receiver 

When setting up the base station at an unknown point, point coordinates can be obtained by 

average collection. (the more coordinates in the average collection, the higher the reliability). 

When setting up the base station on a known point, users can input the coordinates directly, or 

select data from the point library by clicking the point library icon. 

- Antenna: To enter the antenna type management interface and select antenna type. 
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- Target H: Input the instrument height and height type of the base station. 

- Position: The ground reference point of the base station, it can be manually-set or obtained by 

average collection, or from the point library. 

- : Point library. It is used to get points in the coordinate library to the current interface. 

- : Average collection. To enter the average collection interface, the default number of 

smoothing is 10 times. 

 

Figure 3-2-4 Average 

In the Average interface, users can collect points manually 

- Stop: Click the average collection icon and it will start smoothing automatically. Users can 

click Stop to stop it, or click Start to begin the collection. 

- OK: Apply current average coordinate data. 

- Graph: Enter the graphical interface of the average collection, and view the distribution of 

points. 

- Configure: Set the Average Method, Status, Ave Times and Ave Precision. 

- Delete: According to the accuracy of points, users can select the point to participate in the 
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average calculation. Long press on an item, in the list of average points, to delete the point (it 

will be unrecoverable). 

3.2.3 Data Link 

Data link settings are used to set the communication mode and parameters between the base and 

rover, including the Internal UHF, Internal GSM, External Radio, Wi-Fi and Data Collector 

Internet (for specific models). 

    

Figure 3-2-5 Datalink      Figure 3-2-6 Choose the Datalink 

1. In the Internal UHF mode, users can set the Channel, Power, Advance settings (for specific 

models), etc. 
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Figure 3-2-7 Internal UHF 

- Power: There are three options, including high, middle and low options. 

- Advance: Click to enter the interface to get the most suitable channel (for specific models). 

     

Figure 3-2-8 Channel List                  Figure 3-2-9 Frequency 

Click the frequency of a channel to modify the frequency of the channel, within the frequency 

range specified by the channel. 

- Refresh: If the result of the current search is not a suitable channel, users can change the starting 
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channel to continue a new round of searches. 

- Reset: Click to restore the list to default state. 

- Save: After modifying the frequency table, please click to complete the modification. 

    

Figure 3-2-10 Saving Prompt         Figure 3-2-11 Save Success 

2. In Internal GSM mode, users can click Network to choose the network type (GPRS, GSM, 

CDMA). 

    

Figure 3-2-12 Internal GSM        Figure 3-2-13 Network 
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- APN: Different networks will have different settings. 

- Server: Choose the mode. Input the IP and port manually, or click Select to enter the server list 

and choose a suitable server. 

 

Figure 3-2-14 Server 

When in ZHD mode, there are two kinds of group types, including City Number and Base Station 

SN. 

 

 

 

 

 

 

    Figure 3-2-15 Group Type      Figure 3-2-16 City Number     Figure 3-2-17 Base S/N 

 

- By City Number: The Area ID and Group ID are 7 and 3 digits respectively. The group ID 
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needs to be less than 255. The base and rover need the same parameter settings to work properly. 

- By Base Station SN: Input the base S/N, and set the same number in the same way with the 

rover. 

When you use the CORS mode, please set the right IP, port, mountpoint, etc. Then click Set to 

save the settings. 

3. In the External Radio mode, the device can connect to the external radio to transmit data. 

 

Figure 3-2-18 External Radio 

4. For the Wi-Fi mode, after the hand-held controller is connected to a WiFi-enabled receiver, 

through a non-WiFi connection, the data link will add the Wi-Fi mode. In this mode, the receiver 

can be set to connect to a third-party Wi-Fi and send differential data. 
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Figure 3-2-19 Wi-Fi Mode       Figure 3-2-20 Wi-Fi Mode Settings 

Click the Wi-Fi option to enter the Wi-Fi Parameter interface. When the Wi-Fi hotspot is turned 

on, the connection to the Wi-Fi of the hand-held controller is supported; otherwise, a third-party 

Wi-Fi hotspot will be connected. 

    

Figure 3-2-21 Wi-Fi Parameter             Figure 3-2-22 Wi-Fi Hotspot 
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5. In Data Collector Internet mode, it supports ZHD and CORS mode to connect the server (for 

specific models). 

 

Figure 3-2-23 Data Collector Internet 

It uses the hand-held network to connect the server as the RTK, dial-up internet access by the 

network module of the hand-held. Send the received differential data to the host by Bluetooth 

after connecting to the server, so that the host can do network RTK without the SIM card. 

3.2.4 Other Options 

Set the Diff Mode, Correction Type, Elevation Mask and other parameters. 
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Figure 3-2-24 Other 

- Diff Mode: Including RTK, RTD and RT20. The default is RTK, RTD is the code differential 

GNSS positioning, and RT20 is the single-frequency RTK. 

- Correction Type: Including RTCM(3.2), RTCM(3.0), CMR and RTCM(2.x). 

- Diff Port and Baudrate: The default is COM2 and 115200 (unchangeable). 

- Pos Frequency: Software update positioning data frequency, supports 1Hz and 2Hz. 

- Elevation Mask: Adjustable from 0 to 30 degrees. 

- PPK Mode: Connect to a receiver that supports PPK function; the receiver will start a temporary 

static acquisition synchronously after the base turns on the PPK mode. 

Click Set after all the base parameters are set, and there will be a prompt to indicate the success 

or failure of the settings. 
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3.3 Rover 

The rover settings mainly set the working parameters of the rover, including Configure, Datalink, 

etc. 

3.3.1 Rover Configuration 

Users can save all the parameters set in the rover as a configuration file, or load the parameters 

directly from the configuration file. 

In the configure interface, users can click the QR code icon to read the QR code shared by the 

base station, to obtain the configuration parameters quickly.  

 

Figure 3-3-1 QR Code 

3.3.2 Data link 

Rover data link settings are used to set communication types and parameters between the base 

and rover, including the Internal UHF, Internal GSM, External Radio, Data Collector Internet, 

External Network (3G), PPP Service (for specific models), etc. 
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Figure 3-3-2 Datalink 

1. In the Internal UHF mode, users can set the Channel, Protocol, etc. The channel must be 

consistent with the channel of the base. 

2. In the Internal GSM mode, users can click Network to choose the network type (GPRS, GSM, 

CDMA). 

    

Figure 3-3-3 Internal GSM     Figure 3-3-4 APN Parameters 
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- APN: Different networks will have different settings. It’s parameters of the host SIM card. 

- Server: Choose the mode, including ZHD and CORS. Input the IP and port manually, or click 

Select to enter the server list and choose a suitable server. 

- Net Relay: Click to open the net relay option (for specific models), and set the Relay Channel, 

Protocol, Power, etc. Then it can relay to other rovers while working. 

 

Figure 3-3-5 Net Relay 

When use ZHD mode, the settings needs to be same as the base settings. And when you use the 

CORS mode, please set the right IP, port, mountpoint, etc. Click Set to enter the CORS 

Parameters interface, and click Get Mountpoints to choose the suitable mountpoints and input 

the User Name and Password to finish the settings. 
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Figure 3-3-6 Set Rover               Figure 3-3-7 CORS Parameters 

- Open: Load existing CORS parameters. 

- Save: Save the current CORS parameters. 

- OK: Complete the settings and return to the previous screen. 

3. In the External Radio mode, the hand-held controller needs to be connected to a host that 

supports external radio. 

4. In Data Collector Internet mode, users can choose ZHD or CORS mode, and the correction 

data will transmit from the software to rover by Bluetooth. With server support, the differential 

format (including the coordinate system) can be set manually (RTCM 1021: reference ellipsoid, 

RTCM 1023: seven-parameters and RTCM 1025: elevation parameters).  

 

Figure 3-3-8 RTCM Formats 
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The APN of the data collector internet mode are the parameters of the hand-held controller 

system. If the WiFi is not connected, the hand-held controller must be installed with the SIM 

card to do APN settings, otherwise there will be a prompt. 

 

Figure 3-3-9 APN of the Data Collector Internet Mode 

5. In the PPP Service mode, users can set the Diff Mode (satellite or network). 

3.3.3 Other Options 

Set the Diff Port, Pos Frequency, Elevation Mask and other parameters. 

 

Figure 3-3-10 Other 
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- Diff Port and Baudrate: The default is COM2 and 115200 (unchangeable). 

- Pos Frequency: Software update positioning data frequency, supports 1Hz and 2Hz. 

- Elevation Mask: Adjustable from 0 to 30 degrees. 

- PPK Mode: The receiver will start a temporary static acquisition synchronously after the rover 

turns on the PPK mode. It will record the RSP file in the Detail Survey, Stake Points, Stake Line 

when using the average collection. The file name will be consistent with the static collection file 

name.  

 

Notice: 

If the project was turned on in PPK Mode, when setting up the rover, there will 

be a PPK correction prompt when the original data is exported. 

 

Figure 3-3-11 Prompt 

 

Click Set after all the rover parameters are set, and there will be a prompt to indicate the success 

or failure of the settings. 
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3.4 GNSS Demo Mode 

The receiver can simulate measurement data in the demo mode to make it easy to learn the 

software. 

 

Figure 3-4-1 Demo Mode 

Choose the Direction according to demand, including Random, Input, Map and Line. 

 

Figure 3-4-2 Direction 
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- Random: Current point direction is displayed randomly. 

- Input: Specify the travel azimuth. 

- Map: Specify the direction as the direction of the map. There are four options, East, South, 

West and North. 

- Line: Specify the line in the Stake Line or Stake Road. 

Velocity is the moving speed of the current point, it can be a specified speed or random. Precision 

is the precision limitation of the current point, it can be input or given randomly. Start Point can 

be specified with any coordinate. The coordinate can be input, or selected from the point library 

or map directly. 

After completing the settings, click Start to start the demo mode. If the GNSS receiver or built-

in GPS is connected, it will prompt whether to disconnect to start the demo mode. After the demo 

mode is started, the interface will automatically jump to the main software interface. 

 

3.5 Controller 

In this interface, users can check the current hand-held controller type, Bluetooth support status, 

network, serial port, etc. It will display the corresponding model with the Hi-Target hand-held 

controller, and display General for others (all non-Hi Target Android devices). 
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Figure 3-5-1 Controller 

 

3.6 Additional Settings 

The additional settings include module info, registration info, 5-pin port data output, satellite 

tracking switch, receiver settings, service info, restore system, network diagnostics, electronic 

bubble calibration, orientation sensor calibration, magnetic calibration, Wi-Fi hotspot password 

set, update firmware, PPP service authority, etc. Different types of devices or connections 

support different functions. 
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Figure 3-6-1 Additional Settings 

3.6.1 Module Info 

Check the radio module type and network module type. The viewing of module information only 

supports some models. 

- Radio Module Type: Displays the type information of the host radio module. 

- Network Module Type: Displays the type information of the current network module. 

 

Figure 3-6-2 Module Info 

3.6.2 Registration Info 

In the registration info interface, check the device registration code and expiration time. 
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Figure 3-6-3 Registration Info 

3.6.3 5-pin Port Data Output 

Open the 5-pin port data output option; users can select the corresponding port's baudrate, 

commands that need to be sent and the corresponding frequency (1Hz, 2Hz and 5Hz). 

After turning on the settings, static collection will be stopped and it will not be allowed to open. 

If users try to open this option, when using the static collection or the base mode, the software 

will prompt that the current mode does not support this operation. 

    

Figure 3-6-4 Warning     Figure 3-6-5 5-pin Port Data Output 

3.6.4 Receiver Settings 

Set the store RINEX data, stop and go, firmware upgrade prompt, remote connection, USB 

virtual serial port, store static data in receiver SD card, sound type, volume, one-step set station,  
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quasi dynamic RTK, etc. Different hosts have different settings. 

 

Figure 3-6-6 Receiver Settings 

- Store RINEX Data: After turning on, the RINEX format data will be recorded synchronously 

with the static collection. 

- Stop and Go: Support the function to collect temporary static data after turning on. 

- Firmware Upgrade Prompt: After turning on, there will be a prompt when there is upgradeable 

firmware. 

- Remote Connection: The host will automatically connect to the corresponding server after 

turning on. Remote connection IP and port do not need to be changed, the default value is OK. 

- USB Virtual Serial Port: After turning on, users can connect the USB debugging virtual serial 

port. 

- Store Static Data in Receiver SD Card: Set static files to save to SD card. 

- Sound Type: Switch the voice announcement (None, default and user defined). 

- Volume: Adjust the volume. 
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- One-step set station: After turning on, the base can be set automatically after power on. 

- Quasi dynamic RTK: Users can do it in the detail survey after turning on. 

 

3.6.5 Service Info 

The service info interface will display the current receiver version type and its corresponding 

function rights. 

 

Figure 3-6-7 Service Info 
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3.6.6 Restore System 

Restore the firmware to its original state. 

 

Figure 3-6-8 Restore 

3.6.7 Wi-Fi Hotspot Password Set 

To modify the connection password for the receiver's Wi-Fi hotspot, please connect the receiver 

by Bluetooth first. Then enter the old password and new password twice correctly, and click Set 

to complete the operation.  

 

 

Notice: 

1. The default Wi-Fi password is 12345678; 

2.If you forgot the Wi-Fi password, you can use the GNSS Receiver Manager 

→ Wi-Fi Password Settings to set a new password. 
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Figure 3-6-9 Wi-Fi Password Config 

3.6.8 Update Firmware 

Connect the receiver by Wi-Fi first, and choose the file to upgrade the firmware of the host and 

motherboard. The corresponding motherboard can only select the corresponding file to upgrade. 

If the wrong BRD file is imported, the host will prompt ‘upgrade failed’ during the upgrade 

process. This function only works on some models. 

 

Figure 3-6-10 Update Firmware 
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3.6.9 Network Diagnosis 

Check the state of the network module, SIM card, network signal, network registration, dial-up 

and server connection. And this function only supports some specific models. 

 

Figure 3-6-11 Network Diagnosis 

- : Normal. 

- : Abnormal. 

- : Not checked. 

3.6.10 PPP Service Authority 

View and register the PPP service authority information. If the PPP service authority has expired, 

it will be displayed in red. If it has not expired, it will be displayed in black (only supported on 

some models). 
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3.7 Console 

 

It’s mainly used to debug data and detect the GPRS signal strength. It can save the received 

debugging data as files. 

 

Figure 3-7-1 Console 

- Hex: Select to display data in hexadecimal format. 

- Refresh: Select to refresh the output. 

- Save: Select to save the output data. 

- New Line: Select to send the new line, select it when sending commands normally. 

- Send: Click to send the command after entering the command. 

- GPRS Signal Test: When using the internal GSM mode (for some specific models), select and 

click OK to enter the signal test. The current GPRS signal strength will be displayed in the text 

box in the pass-through mode. +CSQ: 6,2 means that the signal strength is 6. 
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Figure 3-7-2 Warning                   Figure 3-7-3 Pass-through Mode 

 

 

Notice: 

The two numbers behind the CSQ represent the GPRS signal strength value 

and the signal symbol error rate. The larger the previous value, the better the 

signal. The last value is 0 normally. 

The software presets commonly-used data types and can receive data without selecting the 

command. Select data types, it supports multi-selection combination sending. Users can select 

Clear to clear the receiver's current data and request the selected data again and then click Send 

to send the data. 

There will be sensor values output when using the demo mode or built-in GPS mode. 
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Figure 3-7-4 Sensor Values 

 

3.8 Static 

3.8.1 Static Settings 

     

Figure 3-8-1 Device Interface               Figure 3-8-2 Static 
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In RTK mode, if users need to do static acquisition at the same time, please click to enter the 

static settings interface to input the interval, file name, pole and elevation mask. Users can view 

the GDOP, start time and recording time. Click Start to start recording. 

     

Figure 3-8-3 Set Duration                         Figure 3-8-4 Static Mode 

The Set Duration function can be enabled only when the Static Mode option is selected (for some 

specific models). After the specified acquisition time is enabled, the current acquisition will stop 

and the receiver will automatically shut down. 

 

Notice: 

The height limit (antenna height) cannot be greater than 65m. If the height 

exceeds 65m, the HGO display antenna will be inconsistent. The software will 

fail and prompt when users input a value that exceeds 65m. The elevation mask 

limit must also not exceed 30 degrees. 
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3.8.2 Static Data Management 

View static files in the current receiver and do some related operations. 

     

Figure 3-8-5 Static Data Management          Figure 3-8-6 Download or Delete 

- Format: Format static data, data is not recoverable. 

- Refresh: Refresh the current file list interface. 

- Download: Connect the receiver by Wi-Fi, it supports the FTP static files download to the local 

store. Long press to choose files, and it will prompt the save path after the download is successful. 

- Delete: Long press a record to delete the selected static data, allowing multiple files to be 

selected and deleted. 
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3.9 RangeFinder 

3.9.1 RangeFinder Connection 

Select the type of the rangefinder to be connected, including the Leica Disto D8/D5/D3 and 

Trupulse 360B, and click Connect to connect. The rangefinder choice is not available if already 

connected. 

    

Figure 3-9-1 Device Interface      Figure 3-9-2 Choose the RangeFinder 

 

3.9.2 RangeFinder Intersection 

Click COGO→Intersection in the main interface to enter the intersection interface. 
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Figure 3-9-3 COGO Interface              Figure 3-9-4 Azimuth Interface 

When the rangefinder device is not connected, users can click the Bluetooth button  in the 

2Pt2L, 2Pt1L, 2Pt1A1L and Azimuth interface to enter the rangefinder interface to connect the 

rangefinder. 

After entering the rangefinder interface, click Connect to connect the rangefinder by Bluetooth 

and use the rangefinder to measure the corresponding value.  

 

Notice: 

When using the software to read the rangefinder ranging value, make sure that 

the rangefinder is in the initialized state and not in the waiting state. 
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Survey 

 

This chapter contains:  

 

■ Detail Survey  

■ Stake Points 

■ Stake Line 

■ Menu 

■ Mapping Survey 
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4.1 Detail Survey 

Click the Detail Survey icon in the Survey interface to enter detail survey; text interface and 

graphical interface can be switched via the  Text / Graph button. 

     

Figure 4-1-1 Survey Interface       Figure 4-1-2 Detail Survey 

     

Figure 4-1-3 Text Icon            Figure 4-1-4 Graph Icon 

Navigation        Zoom in       Zoom out     Zoom center 

Zoom All         Attribute Info    Select Point   Intersection 
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Auto Survey       Turn off Auto Survey    Average Survey 

Manual collection  Expand Tools        Hide Tools      Culture Create 

4.1.1 Map Navigation    

Enter the Survey interface; the map navigation  is shown when the left toolbar is hidden. It 

allows users to view the current position, or search for a point position more intuitively, and the  

navigation tool provides three types walk, driver and bus for route searching. 

    

           Figure 4-1-5 Map Navigation Icon       Figure 4-1-6 Map Navigation 

 

Notice: 

1. In  Survey interface you can enter map interface by clicking the  icon. 

2. Map navigation function doesn’t display the points collected during 

measurement; The third party map in the configuration can display the points 

of the measurement. 

3. It not only supports domestic maps, but also offline maps (download offline 

maps in configuration). 
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After entering the Map navigation interface, the same tools as the survey interface will not repeat 

the introduction; add the following functions: 

Satellite Imagery   ：Layer General    ：Route Search    ：Point Search  

Click and tools, loaded map can be switched between satellite image and layer general. 

    

                 Figure 4-1-7 Satellite Imagery          Figure 4-1-8 Layer General 

During the survey, you can use the function point search  if you search for the position of a 

point, use  for route search. The coordinates of the search point can be obtained by real-time 

collection, point library, graphic selection and manual input, and then clicking Search. Back to 

the map interface, the red icon on the map is the position of the search point. If you want to 

search the route to the point, click Go Here, then it will display route mileage at the bottom of 

the screen; you can select three methods walking- , driving and bus. Click Details to view the 

detailed route of start to end points. 

If you know the start and end points, you can use the route search . After entering its interface, 
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select the route type, input coordinates of start point and end point, and then click Search. 

    

Figure 4-1-9 Search                          Figure 4-1-10 Go Here 

    

          Figure 4-1-11 Route                          Figure 4-1-12 Route Detail 

 

4.1.2 Manual Collection 

In general, you reach the survey position, according to the survey coordinates, accuracy and 
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solution state displayed on the interface, and then decide whether to collect points. General RTK 

Fix solution; click for manual collection, the software first checks the accuracy (accuracy 

settings in Surveying Configure → Data in detail). If accuracy is not required, the software will 

be prompted. 

Before completion of the collection the interface of Save Point will pop up with the details, you 

can check the reliability of the point; at the same time, the software automatically records data 

cumulatively, according to the global point number and the prefix of point name from last use. 

You can directly input Target H, and also click Pole for detailed settings of target height 

configuration and antenna type. Code can input note information, and you can also select 

commonly used note types; Set Station in the collection confirmation frame. 

    

                   Figure 4-1-13 Bubble Warning           Figure 4-1-14 Save Point 

 

 
4.1.3 Culture Create 

Open the culture creation. After, you can take the point of real-time collection as the point of 
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culture creation: collection point and detail point are synchronously connected. On finishing 

Culture Create, it will prompt line collection in a pop-up window, which displays whether to 

close the ticked culture; do not tick Culture Close to create a line, tick to create the surface, and 

mark on the map. 

A hidden bar at the bottom displays WGS-84 BLH, local NEZ and BLH coordinates, with left-

right sliding to select to display coordinate types. 

  
Figure 4-1-15 Culture Create 

 

 

 

 

 

 

 

 

Collection mark 

 Culture create switch 

: On : Off 

：关 开 

 
Coordinate display area 

：关 开 
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                  Figure 4-1-16 Line Collection                        Figure 4-1-17 Line 

 

 

 

 

 

 

 

 

 

Figure 4-1-18 Polygon                             Figure 4-1-19 Face 

 
 
 

 
 
 

4.1.4 Collect Input Method 

After demo mode, built-in GPS or connecting device, it can support electronic bubble survey.  
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It will display the diagram of the electronic bubble position in the software interface, you can 

select electronic bubble automatic survey in Auto and automatic collect point according to the 

state of electronic bubble. Electronic bubble has the following states: 

- center: Bubble is within the set limits, center good. 

- Wait center: Waiting for user to adjust the pole to center the bubble. 

- Wait survey: Waiting 2 seconds after center, enter the survey state, and collect points in this 

state. 

- Wait move: After the last collection point is finished, it waits for you to move the pole; after 

moving a distance it will start the next survey. 

- Out of Range: In the set limits, bubble deviates from the center position. 

     

Figure 4-1-20 center       Figure 4-1-21 Out of Range        Figure 4-1-22 Wait 

When collecting coordinate points, it supports input voice and photo attributes of coordinate 

points. In the prompt box or text interface, click  to enter Audio or Image information, 

and you  can input and view voice and photo information; after point collection, the attribute is 

saved in the file. It supports voice and picture file addition; click Add File, audio file format can 

be *.amr, *.wav, *.mp3 and image file formats supported are *.jpg, *.png, *.bmp.  
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      Figure 4-1-23 Audio            Figure 4-1-24 Prompt        Figure 4-1-25 Audio Format        

     

     Figure 4-1-26 Image             Figure 4-1-27 Prompt       Figure 4-1-28 Image Format 

After returning to the parent interface, once the user has input voice or photo information, the 

interface icon is changed to . 

When you select point description information, you can directly select the common description 

information, or manually edit the property.txt file (/sdcard/ZHD contents) according to the actual 

work situation. The edited description information will be displayed in the description list. 

 

4.1.5 Automatic Collection 
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Click the Auto icon  , enter automatic collection interface, select automatic collection mode 

(including Time interval, Plane interval (N or E direction change value), Slant Interval, 

Electronic bubble center), input the prefix, number, annotation and other information of the point 

name. Click OK; the software enters automatic collection mode. Accuracy will be checked 

during automatic collection (accuracy is set in Surveying Configure → Data has a detailed 

description. If it meets the accuracy requirements, it will automatically collect and prompt to 

save points; if it does not meet the accuracy requirements, there will be no prompts until the 

accuracy meets the requirements to continue to automatically collect and prompt points to 

save):click  to finish automatic collection. 

     

                      Figure 4-1-29 Auto Method      Figure 4-1-30 Auto Interface 

When the automatic collection mode is Time, the interval(s) value can be set, and it will be  in 

automatic collection mode, according to the set time interval. 

When the automatic collection mode is Distance, the interval(s) value can be set, and it will be 

in automatic collection mode, according to the set plane interval. 
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When the automatic collection mode is Slant Distance, the interval(s) value can be set, and it 

will be in automatic collection mode, according to the set slant interval. 

When the automatic collection mode is Bubble is centered, hold it straight for automatic 

collection, and take away immediately after collection, with no further human intervention. 

Clicking on the upper-right corner of the interface Configure → Data → Bubble Precision can 

set the bubble precision. 

 

Figure 4-1-31 Auto Collection Interface 

4.1.6 Average Collection 

Average Collection is a simple way to improve measurement accuracy; according to the error 

theory, the error occurs in any direction, so if there are a large amount of observed quantities, 

accidental errors will be offset (but it’s just theory, it doesn’t mean that the more observed 

quantities, the higher the precision). In Average Collection interface, click Start, the software 

will collect points, and display the current point position at the same time. The software 

automatically analyzes the quality of the data, then calculates and displays standard deviation 

(root mean square error). 
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Average Collection supports text and graphic displays. After average collection reaches the set 

number and stops, in the Text interface, you can delete some scattered points in the average list 

to improve the collection accuracy (long press average list, display Delete toolbar), and then the 

software will automatically redo the average calculation. In the graphic display interface, click 

on the average collection point to display the point coordinates. 

       

  Figure 4-1-32 Average             Figure 4-1-33 Text           Figure 4-1-34 Graph 

The calculated error is the same as the error of the measurement. However, because the average 

process is from a small collection of data, the estimated error may be less than the actual 

measurement error. 

Configuration can be done before average collection; click Configure in the upper right of the 

collection interface. Set the average type, solution type, average times, average precision. Each 

time you exit the software, the solution type of the average collection configuration is set to the 

fixed solution. It cannot be configured during average collection. If it fails to achieve the average 

accuracy, as well as configuration over-limit, it will prompt Unable to start average due to low 

precision. Then you need to reconfigure the average precision. 
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Figure 4-1-35 Configure   Figure 4-1-36 Precision 

4.1.7 Indirect Survey 

Intersection collection is designed for places where we cannot reach or there is no GNSS signal. 

Usually only plane coordinates can be obtained by intersection, and the elevation data should be 

obtained by other measurements. The principle of intersection is a simple graphical intersection 

calculation; there are many intersection ways, with different required quantity, you can choose 

according to your measurement tools (please refer to chapter 5 of this book for specific usage: 

Tools→Intersection). 

 

Notice: The points calculated by intersection are saved in Coordinate Data and 

Raw Data. 

 

4.1.8 Attribute Querying 

Click  to open Attribute Querying, to go directly into the Attribute Querying state; it supports 

query line, face. Click and select line, face on the graphics, it will show the length of the line, 

the area, mu and length of face, and can delete, modify operation; after the operation click OK 
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or Cancel. Click  again to exit the attribute querying.  

       

Figure 4-1-37 Attribute          Figure 4-1-38 Line Info         Figure 4-1-39 Face Info 

4.2 Stake Points 

                                          

                                                                 Figure 4-2-1 Stake Point 

 Choose node on line      Select Point         Nearest Stake Point 

 Average Collection      Select Stake Point      Single Collection 

- Select Stake Point: In the Stake Point interface click  , enter Select Stake Point interface; it 

Stake instructions: Forward and 

Towards the Left to 0 means it has 

reached stake point. DeltaH represents 

the Verticals difference between the 

stake point and current point. 
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provides three ways to define a point:  

1. Manual input. 

2. Select from the Coordinate Library. 

Enter the name of the point to be searched at the point name, click the search button  to 

search from the Coordinate Point Library, Stake Point Library and Control Point Library, 

Mapping Data Point Library, Cross section Point Library. The search results are displayed in 

the interface for user selection; if you do not find the coordinates of the specified point, a name 

will be prompted. 

        

Figure 4-2-2 Search Icon        Figure 4-2-3 Results         Figure 4-2-4 Select Point 

3. Select from picture (select point on line  and select point on the map ). When at stake 

point, click  , it will automatically extract the coordinates of Stake Point Library, according 

to the positive sequence or reverse order to stake out. In Select Stake Point interface, check Save 

to Stake Pts Lib: corresponding points can be saved to the Stake Point Library.  

- Nearest Stake Point: End users click  icon, you can set the nearest point as the current stake 

point; in the process of approaching the nearest stake point, if you configure options such as 

voice prompts, precision, and prompt on approaching point etc., the software will make a prompt, 
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according to the distance, such as icons, voice and words. 

 

 

4.3 Stake Line 

Stake Line is a simple local staking tool. There are four basic lines: line, arc, spiral curve and 

circle. The line can be defined by two point coordinates, or one coordinate and the azimuth for 

plane or space; the arc can be defined by 2 points, or a unified curve metamodel with one point 

and the azimuth; the spiral curve can be defined by a unified curve metamodel with one point 

and the azimuth; the circle can be defined by the center and radius. (Note: in order to unify the 

concept, we think that stake of one line is the stake of a circuit, for each stake point, its position 

is only indexed by mileage). 

Usually, stake line first needs to select line style. 

Click  to enter Stake Line Library; it defines line data, and includes four types of lines: Line, 

Arc, Spiral Curve, and Circle. You can add, edit, delete, create, load, save, save as, and open 

data for the Stake Line Library.  

    

Figure 4-3-1 Stake Line Library   Figure 4-3-2 Stake Line Interface   
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                               Figure 4-3-3 Add Type        Figure 4-3-4 Stake Circle 

- Add: Add the relevant parameter information of Line, Arc, Spiral Curve, and Circle, according 

to your requirement.  

- Edit: Edit selected existing line elements. 

- Delete: Delete the selected stake line. 

- Create: New *.line file. 

- Load: Accumulate line metafiles, the software will select the line element in the file and then 

switch to other projects and switch back. The loaded line element will be displayed in Stake Line 

Library. 

Line library file (*.line) is the internal format of the software; add, edit, and save data by using 

software. Two-point-line file (*.2pt) is a public format, it can be edited by the user, choose to 

load Two-point-line to the Stake Library in the software.  

- Save and Save as: Save current line element information. 

- Open: Open the *.line file saved in /ZHD/Project/ROAD/Unnamed. 

The following are the descriptions of each line type. 
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4.3.1 Define Line 

Click Line button; enter line parameter definition menu - you can select to define a flat line or a 

three-dimensional line. The software provides two types, Two-points to determine line and one 

point + azimuth; if you select Two-points to determine line, extract two point coordinates from 

the Point Library, input the start mileage; If you select a point + azimuth, you only need to 

extract the coordinates of a point from the Point Library, then input the azimuth of the line and 

the start point mileage, and click OK. 

Click sample point  , input the mileage to be staked. Among them, the mileage and margins 

will automatically accumulate according to the increments. Click OK to enter the stake interface. 

Calculate the position of the stake point and input mileage; (if necessary, calculate side stake), 

the Up and Down icons in the interface help to quickly adjust the mileage value, unit adjustments 

are the increments, the data is recorded in global variables. So each time you enter the interface, 

the software automatically calculates a mileage/offset as the default value to save time. For 

example, to stake a pile every 10 metres, set the increment to 10, the mileage of the starting 

stakeout point is 1850. After the end of the first point of thestakeout, enter this interface again. 

The software will automatically calculate the mileage as 1860, so click OK and continue to work. 

- Mileage: Mileage of current stakeout points. 

- Offset: In the direction of increasing mileage, the distance from the current point to the vertical 

line of the defined line (left is negative and right is positive). 

- Step: Each time you enter a menu, the mileage increases. 

- Direction: Taking defined line as the reference, set the direction to the left or to the right.  

According to the prompt, the process of staking the specified milestone points is the process of 

the current point (triangle) closing to the target point (circle with cross). 
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Figure 4-3-5 Stake Line One 

 

Figure 4-3-6 Stake Line Two 

 

 

Figure 4-3-7 Sample Point 

Miles of current stake 

point K0+0.00 
 

Stake tips 

Display real-time mileage, real-

time display of the distance from 

the current point to the line 

segment 
K0+0.00 

Manually increase the mileage, 

automatically increase one 

increment per click Mileage. 
Manually increase the 

offset, automatically 

increase one increment 

per click offset. 
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Notice: Offset is generally used when the road side pile; Left or Right in 

Deflection represents the left and right of the line, respectively; input 

distance from the center line to the edge line, in increments of zero, to 

stake a specific mileage. 

              In addition, when opening the real-time mileage function, the 

software will project the current position point on the line and display 

the mileage of the projection point, which is helpful to determine the 

walking direction. 

 

Select the Three-dimensional line to define a three-dimensional line. Three-dimensional lines 

are defined in two types: Two-point and One point + Azimuth + Slope. 

When three-dimensional lines are staked, the defined stake miles are three-dimensional spaces 

long, and non-traditional two-dimensional projections are long. 

In order to guide the destination, the software draws a connecting line, just make sure that the 

current walking direction coincides with the connecting line, to ensure that the walking  direction 

is correct. At the same time, there are some guidelines below, for some strong sense of location, 

or point to clear areas, can be the software below the lofting instructions guide. 

Stake instructions can be selected in two types: Front-Back, North-South. In the configuration 

item of the configuration interface, select the stake prompt types you want. 

If you turn on Real-time Mileage HT Diff, the current mileage will be displayed on the interface, 

and its connection with the current point will be drawn. Draw a small dot on the line to indicate 

the position of the projection; Real-time Mileage is also used to determine whether the direction 

of walking is correct (compare real-time mileage with stake point mileage, and increase 

direction).  
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Notice: Triangle is the position and velocity direction of the current point, 

circular icon is the target point, the dotted line is the line connecting 

the current point and the target point. As long as the walking direction 

coincides with the connecting line, it is possible to ensure that the 

stake direction is correct, so that the target point can be easily found. 

The following information box is the staking information, indicating 

the difference between the walking direction and the vertical 

direction. 
 

 

 

 

 

 

 

      Figure 4-3-8 Stake             Figure 4-3-9 Close          Figure 4-3-10 Success 

- Green: When close to the stake point it prompts Reach the preset tip range. 

- Red: Stake success prompts Reach the set stake precision. 

You can also turn on staking voice prompt in the configuration. When reaching the preset prompt 

range, and reaching the lofting accuracy, the hand-held will give different voice prompts. 

4.3.2 Define Arcs and Spiral Curves 

Click the Arc or Spiral Curve to define the line type; after defining the line style, the staking 

function is similar to Line. You only need the Stake Line interface; click the Stake Point  , 
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input the mileage to be the stake point. Among other data, the mileage and margins will 

automatically accumulate according to the step. Click OK to enter the stake interface. 

       

Figure 4-3-11 Arc         Figure 4-3-12 Spiral Curve        Figure 4-3-13 Radius 

- 2 Points: Input line name, start and end point coordinates, start point mileage, radius and 

deflection direction; 

- Point + Azi: Input line name, start and end point coordinates, start point mileage, radius, 

azimuth, length and direction. 

 

- Radius of Start: Spiral curve of radius of start, check ∞ to indicate a straight line.  

- Radius of End: Spiral curve of radius of end, check ∞ to indicate a straight line.  
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4.4 Menu 

Click the menu button of the hand-held in the Detail Survey/Stake Point/Stake Line interface; it 

will pop up a menu button for quick jumps or data viewing between associated interfaces. 

 

Figure 4-4-1 Menu Key One 

Click the menu button of the hand-held in the Base/Rover interface, to pop up the device 

connection button to quickly jump to the device connection interface. 
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Figure 4-4-2 Menu Key Two 

4.5 Mapping Survey 

Mapping Survey is the work of measuring the plane coordinates and elevation of the control 

points needed for the mapping. 

 

Figure 4-5-1 Mapping Icon 
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The accuracy of the map root point, RMS in point position relative to adjacent level control point, 

should not be greater than 0.1mm on the mapping; The error of elevation should not be greater 

than 1/10 on mapping.  

Enter the Map root measurement interface; to see the map root acquisition progress, click 

Configuration setting parameters, the configuration page can automatically record the last input, 

and the name of point can be increased. 

- HRMS: The horizontal RMS of the current point;  

- VRMS: The vertical RMS of the current point. 

 

 

   
 Figure 4-5-2 Mapping Survey       Figure 4-5-3 Start Survey 

○1  

○2  

○3  

○4  

○5  

○6  

○7  

○9  

○8  
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          Figure 4-5-4 Plane Limit Type      Figure 4-5-5 Ave Precision 

 

 

○1  Edit point’s name, or it will automatically add by default 

○2 Input map root point of description           ○3  Motherboard reset interval (s) 

○4  Progress of smoothing times per return    ○5   Motherboard reset progress 

○6   After the parameters are set, click Start 

○7 Click to select target high type, input target high 

○8  Measured number and progress 

○9 Can be stop or pause during mapping root collection 

○10  Select Plane Limit Type 

○11 When the plane limit typed is selected as the integrate, then the integrate is set here, 

conversely, it is each component 
 

 

○12 Press to open, you need to set Σn, σe, Σz precision. 

4.5.1 Mapping Data 

Project interface → Mapping Data; you can view all map root measurement data, and you can 

○12  

○11  

○10  
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also create, open, or search for data. Long press the map root point to delete and edit. 

 

     

Figure 4-5-6 Mapping Data       Figure 4-5-7 List             Figure 4-5-8 Long Press 

4.5.2 Mapping Survey report export 

Project interface→Project Information; click icon to export mapping reports in *.html format 

by default. The report can view the measured antenna height, observation time, and XYZ and 

BLH values of field observations at the map root point of the plot (the optimal value in 3 tests, 

the optimal value of 1 total data, and the average value of 4 data). Average collection of data for 

each point of DX, DY, DH, in the Statistical data table can also see the xyh point of Error (RMS), 

the point and maximum value of HRMS, aesccording to the percent of pass, it can judge whether 

the point is available. 
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Figure 4-5-9 Export                Figure 4-5-10 Format 

 

 

 

 

 

 

 

 



Road 

159 

 

 

 

 

 

 

Road 

 

This chapter contains:  

 

■ Operation Procedure 

■ Stake Road 

■ Road Design 

■ Store Cross-section 

■ Cross-section Points 

■ Surface 

■ Elevation Difference 

■ Surveying Configure 
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5.1 Operation Procedure 

The road engineering survey contains the route reconnaissance and design survey and road 

construction survey. 

1. Route reconnaissance and design survey 

Preliminary measurement: Control measurement. Measure the strip topographic map and profile 

diagram, collect geological hydrological data along the line, do the paper location or site location 

and make comparison plans to provide a basis for the preliminary design. 

Decided measurement: Route center line survey on the route of the selected design. Measure the 

profile diagram, cross-sectional profile, bridges and culverts, route crossing and facilities along 

the route to provide information for the construction design. 

2. Road construction survey 

Follow the design drawings to restore the road, measure the subgrade sidepiles and vertical curve, 

and do the project completion acceptance measurement. 

 

5.2 Stake Road 

Stake road is the key function of the Hi-Survey Road. The excellent working mode will make 

the surveying more efficient and systematic. 

Stake road and stake line operations are mostly the same. The definition of the road is more 

complicated than the definition of the line, it will use the profile diagram and cross-sectional 

profile to design the line, so the calculation is more complicated. But, relatively speaking, the 

difference between the process of the stake road and stake line is only based on the operation  
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of defining the line; point collection and staking-out operation are the same. 

    

Figure 5-2-1 Survey Interface     Figure 5-2-2 Stake Road 

1. Load the road line 

Click  to enter the road designer file interface, load the centerline, profile, cross-section and 

side-section. Check the file path, and click Display to view the graphic and check the data. 

    

Figure 5-2-3 Road Designer File           Figure 5-2-4 Formats 
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Click  to switch the perspective (top view of the road or cross-section), and there will be the 

Side-section for users to choose if the side-section and cross-section are enabled. 

If there is no profile elevation, cross-section elevation collection and side-section staking-out 

can’t be done. Because the elevation is not known, it’s impossible to get the height of filling and 

cutting. 

In the cross-section view, the red dot indicates the corresponding position of the current position 

in the cross-section. In the upper left of the interface, the current real-time mileage and the offset 

from the center line are displayed. At the bottom left of the interface, the height of filling and 

cutting is displayed. 

 

Figure 5-2-5 Cross-section View 

2. Confirm the location of stakeout points. 

Click  to input and adjust the milestone and offset manually, or by and buttons. Click 

OK and the coordinate of this position will be calculated as the coordinate of the stakeout point 

automatically. 
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Figure 5-2-6 Sample Point 

- Use: Stake out the stakeout point; the graphic interface will display the dashed line connection 

between the current point and the stakeout point, as well as the stakeout indication. 

    

Figure 5-2-7 Stake Road               Figure 5-2-8 Menu Key 

- : Menu key. Click to display and check the data status. 
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3. Stake out 

This process is the same with the stake line operation. 

 

5.3 Road Design 

In the Stake Road interface, click  to enter the road designer file interface. For the centerline, 

users can load the Line Element File(*.sec), Points of intersection(*.PHI), XY File(*.XY), 

Poling Data(*.CSV), Elcad(*.ICD), Coord File(*.Zline), HDPM(*.pm), WDPM(*.pm) and 

LandXml File(*.xml), and click Break Chain to edit. For the Profile, users can load the PVI 

file(*.PVI) and LandXml File(*.xml). For the Cross-section, users can load the Template 

File(*.TPL) and LandXml File(*.xml). For the Side-section, users can only load the BPI 

File(*.BPI). After loading, please click Display or Clear to preview or delete data. 

 

Notice: It’s not possible to do the next mileage collection and stakeout without 

the centerline; and the slope cannot be staked out without the cross-section 

design line. 
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Figure 5-3-1 Survey Interface           Figure 5-3-2 Road Design 

  

5.3.1 centerline 

There are many methods for centerline alignment, including the Intersection, Element and 

Coordinate methods. The intersection method is based on certain conventions; there are certain 

restrictions on the type of lines. The element method can combine line shapes arbitrarily, it 

supports polylines and is suitable for complex curves, including oval lines, multi-intersection 

curves and imaginary intersection points. The coordinate method is similar to the element 

method, but the definition of each line element is determined by defining coordinates of the start 

and en point. The line element format (*.sec) files won’t contain the polyline corner information, 

so if the polyline corner information is needed, please save the file as the Coord File (*.Zline) 

format. 

The Hi-Survey Road supports the Intersection, Element and Coordinate methods and the default 

line element combination within the intersection is the straight line - the first transition curve - 

circular curve - the second transition curve. It supports the smooth transition curve, and the non-

smooth transition curve supports the transverse import. 
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Notice:  

1. Two transition curves can be asymmetrical. 

2. The reverse loop needs to be treated as a non-reverse loop, such as adding 

an intersection. 

3. It supports the imaginary intersection point. 

4. It supports the local curve, and the transition curve length can be zero. 

 

1. Intersection method 

 

Figure 5-3-3 Intersection 

- Intersection JD1/JD2: The intersection of two adjacent lines. 

- ZH: The point where the straight line intersects with the first transition curve, that is, the start 

point of the first transition curve. 

- HY: The point where the first transition curve intersects with the circular curve, that is, the end 

point of the first transition curve. 

- YH: The point where the circular curve intersects with the second transition curve, that is, the 

start point of the second transition curve. 

- HZ: The point where the second transition curve intersects with the straight line, that is, the end 

point of the second transition curve. 
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- ZH-HY: The first transition curve. 

- YH-HZ: The second transition curve. 

- HZ-ZH: The straight line. 

- HY-YH: The circular curve. 

Click Intersection to enter the intersection table data-editing interface. Click Add to add the 

intersection information, input the information manually or select the point from the point list. 

 

 

    

Figure 5-3-4 Intersection Interface    Figure 5-3-5 Add Intersection 

- Load: Open the existing Points of intersection (*.PHI) or Poling Data (*.CSV) file. 

- Save: Save the file in the *.PHI format. The default save path is the ZHD/ROAD folder. 

- Export: Export the file in the Poling Data (*.CSV) or Line Element File (*.sec) format. The 

default save path is the ZHD/Out folder. 



Hi-Survey Road User Manual 

168 

 

 

Figure 5-3-6 Break Chain Pile 

- Break Chain: Long press the break chain pile record to delete or edit the break chain data. 

 

    

Figure 5-3-7 Record Operation           Figure 5-3-8 Virtual Point 

Long press to select and operate the intersection record. 

- Delete: Delete the existing point record. 

- Insert: Insert a intersection data above the selected point record. 
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- Edit: Edit existing intersection data. 

When adding the intersection data, the software will identify the suspected oval curve and users 

can change the data manually, according to the prompt. 

It supports the virtual point option with the imaginary intersection point and reverse loop. Input 

the first point of the virtual point combination normally, and open the virtual point option after 

the second point is entered. 

Click View to check if the centerline graphic is correct.  

 

 

    

Figure 5-3-9 centerline Preview            Figure 5-3-10 Detail 

- Detail: Click to enter the interface to check the detail parameters, including the Intersection 

Points, Line Element and Key Pts. 

- Compute: Input the station and offset; it can check the coordinates; input the coordinates, 

calculate the station and offset. 
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Figure 5-3-11 Compute 

- : Click to input the limit point manually. Users can also select it from the point list or do 

real-time collection to get the point. 

 

Figure 5-3-12 Limit Point 

- : Change the line. Click to choose the point to be changed (start and end points are not 
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selectable), and change it by Manual input or Select from map. 

    

Figure 5-3-13 Change the Point     Figure 5-3-14 Change Methods 

 

- : Line auxiliary points. Click to view corresponding auxiliary points and auxiliary dashes 

in the figure. 

 

Figure 5-3-15 Line Auxiliary Points 

Click Use to load the currently edited line data into the project, and users can select whether to 

save the defined or modified line data. 
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2. Element method 

Element alignment decomposes the combination of complex route lines into several linear units. 

If there is information (coordinates, tangential direction, radius of curvature, etc) about the 

starting point of the route plane curve, the unit that extends in any direction can be set from the 

start point, and the end point information of the unit can be calculated. Then the end of this unit 

can be used as the starting point for the next unit. 

Common lines contain the straight line, arc and spiral curve. Users can input the line manually 

or load files directly, including the Line Element File (*.sec), HDPM (*.pm), WDPM (*.pm), 

LandXml File (*.xml) and Poling Data (*.CSV) formats. 

 

    

Figure 5-3-16 Element                  Figure 5-3-17 Add 

In the general working process, users need to input the coordinate of the starting point, mileage 

and azimuth. Click Add to choose the line type and input the information. 
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Figure 5-3-18 Line               Figure 5-3-19 Arc            Figure 5-3-20 Spiral Curve 

- Line: Input the Length, Start Offset and Start Azimuth. 

- Arc: Input the Start Radius, Length, Direction, Start Offset and Start Azimuth. 

- Spiral Curve: Input the Start Radius, End Radius, Length, Direction, etc. 

Click Start to enter the element interface to edit the start point. 

 

 

Figure 5-3-21 Start Point 

Click View to preview and edit the centerline. 
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Figure 5-3-22 Preview                     Figure 5-3-23 Detail 

- Detail: Click to check the detail parameters, including Line, Curve and Arc. 

- Compute: Input the station and offset, it can check the coordinates; input the coordinate, 

calculate the station and offset. 

2. Coordinate method 

The coordinate method is similar to the element method, but the definition of each line element 

is determined by defining coordinates of the start and end  point. It can only load the Coord File 

(*.Zline) format. 

In the general working process, users need to input coordinates of the start and end  point. Click 

Start to input the station and coordinate manually, or select points from the point list. Click Add 

to choose the line type to input the line information. 
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Figure 5-3-24 Coord Interface               Figure 5-3-25 Add Lines 

- Line: Click to input the coordinates of the start and end  point. 

- Arc: Click to input the coordinates and arc information. 

5.3.2 Profile 

The profile is an expression of the vertical movement of the road (the line fluctuates). It can be 

added manually, and users also can load the file in the PVI file (*.PVI) or LandXml File (*.xml) 

format. 
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Figure 5-3-26 Profile Editor        Figure 5-3-27 Slope Point Data 

Click Add to add the slope point data, and long press the record to delete, insert or edit it. Click 

View to check the profile preview, and input the station value to check the height of the station. 

    

Figure 5-3-28 Profile Preview           Figure 5-3-29 Check Station 

5.3.3 Cross-section 

The cross-section interface contains three options, including Standard, SuperEle and WidePlus.  
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Users can add, edit and delete the cross-section data.  

1. Standard 

    

Figure 5-3-30 Standard            Figure 5-3-31 Template Editor 

- Left-right Identity: The selection indicates that the left and right slopes are consistent, and the 

right slope data will be covered with data symmetrical to the left slope (the original right slope 

data will be covered and cannot be recovered). 

- Name: The name of the current plate. 

- Grade: From the middle of the road, uphill is positive and downhill is negative. The slope 

value is the ratio of the height difference between the two ends of the plate and the width of the 

plate. 

- Wide: The width of the current plate. 

- Curb: Click to input the height difference of the curb. 

Click View to check the template preview, and input the station value to check it 

 



Hi-Survey Road User Manual 

178 

 

 

 

 

Figure 5-3-32 Template Preview 

 

Notice:  

There is only one cross section in memory. A road has different cross-sections 

at different road sections. Users can predefine several typical cross-sections 

according to their needs, and then transfer the cross-sections suitable for the 

terrain in different sections to stake out. 

 

2. SuperEle 

It’s a way to make the road a lateral high-internal one-way cross slope to reduce the centrifugal 

force generated by a vehicle driving on the curve road. 

In the SuperEle interface, users can choose the corresponding cross-section and input the super 

elevation information. 
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Figure 5-3-33 SuperEle                Figure 5-3-34 Edit SuperEle 

Click View to check the template preview, and input the station value to check it. 

 

Figure 5-3-35 Preview 

3. WidePlus 
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In order to make the road surface transition from the normal width to the curve, a widened width 

is set so that a transition zone of curve widening needs to be set. In the transition zone of curve 

widening, the road surface has a gradually varying width. There are different settings methods 

of different road properties and levels. 

In the WidePlus interface, users can input widening change point information according to 

design drawings. 

    

Figure 5-3-36 WidePlus                 Figure 5-3-37 Edit WidePlus 

Click View to check the template preview, and input the station value to check it. 

 

Notice:  

Users can switch Standard, SuperEle and WidePlus interfaces to view road 

data, and click Use on any of the three interfaces to apply the current cross-

section to the road after confirmation. Users can also click More→Save to save 

it as the Template File (*.TPL) for subsequent loading and reuse. 
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Figure 5-3-38 Check Station             Figure 5-3-39 Load or Save 

5.3.4 Side-section 

In the Side-section interface, users can add, load, apply, and save the side-section. 

 

Figure 5-3-40 Side-section 
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- Add: Click to choose and add the Fill or Cut. Input the side-section name, and edit the side-

section features. 

    

Figure 5-3-41 Side Name                     Figure 5-3-42 Features 

- Load: Click to load the BPI File (*.BPI), and the side-section list will show all the section 

information in the current file. 

 

 

 

 

 

 

 

Figure 5-3-43 Load 
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- Apply: Click to apply the slope in the current side-section list to the current project road, and it 

will prompt Use data successfully. 

- Save: Click to save the file in the BPI File (*.BPI) format. 

Long press the record to delete or edit the side-section information. 

    

Figure 5-3-44 Delete or Edit                 Figure 5-3-45 Side Preview 

- Delete: Click to delete the side-section record. 

- Edit: Click to edit the hillslope, platform and ditch; click View to check the side preview. 
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5.4 Store Cross-section 

    

 

 

 

 

 

 

Figure 5-4-1 Store Cross-section   Figure 5-4-2 Road Designer File 

Click  to load existing road designer files, then click  to define a specified mileage of the 

cross-section and input other settings. It will automatically calculate the cross-sectional position, 

at that distance, and display a dashed line as a reference line on the graph. 

    

Figure 5-4-3 Define               Figure 5-4-4 Data Settings 
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When approaching this reference line, the software will calculate the distance between the 

current position and the reference line. If the distance is less than the setting value of the cross-

sectional tolerance (the value can be set in Configure→Data), users can do a cross-section point 

acquisition. 

    

Figure 5-4-5 Cross-section Info      Figure 5-4-6 Cross-sectional View 

- : Click to collect points and input the cross-section information. If the Center Point is 

selected, the point will be used as the reference point of the cross-section. The cross-section point 

library will store the horizontal elevation of other points on the cross-section relative to the center 

point (each section must define a section mileage and collect the center point, otherwise the 

section points collected in this section will be invalid, or users need to add the center point 

manually afterwards). 

- : Click to switch to the cross-sectional view and check it. 
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5.5 Cross-section Points 

Cross-section data can be edited and managed in the cross-section points library. 

 

Figure 5-5-1 Cross-section Points 

- Center Point: Click to add the center point. 

- Open: Open other files in the project. 

    

 

 

 

 

 

 

Figure 5-5-2 Export                Figure 5-5-3 Export Formats 
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- Export: Export files to other data formats, including HDMX (*.DMX), CRECG (*.txt), HDM 

(*.hdm), WDMX (*.dmx ), BGHN (*.bghn), HDMG (*.DMG), South CASS7.0 (*.dat), South 

CASS7.0 (*.hdm), Defined (*.txt) and EICAD (*.HDX). 

- Load: Load and merge cross-section data in current or other projects. 

- New: Create a new cross-section points file in the project. 

- Work Cal: Click to enter the Earthwork Calculation interface. 

In the Earthwork Calculation interface, it will load all the cross-section points by default to the 

calculation list. Click the point name to choose whether to participate in the calculation. 

 

Figure 5-5-4 Earthwork Calculation 

The earthwork calculation requires at least two cross-section points and corresponding center 

points within the range of start and end  mileage. If the Multi-transect mode is selected, please 

input the projection distance limit in the input box. The result of the calculation is the amount 

of earthwork between the two cross-sections that are closest to the start and end  mileage. 

The earthwork calculation provides two methods, the Average Method and Pyramid Method.  
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The average method is simple and practical, but accuracy is not  good. When the adjacent cross-

sectional areas have a large difference, the pyramid method is more accurate. 

 

5.6 Surface 

    

Figure 5-6-1 Surface Function                Figure 5-6-2 Surface List 

This function is to design the DTM surface. Users can manage, add, delete, edit, import and 

preview the DTM surface. 

- Add: Click to add the surface. Set the surface name, point name and coordinate. The point 

information can be obtained from real-time acquisition, point library or map selection. A DTM 

surface should contain no less than three points. 
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Figure 5-6-3 Add New Surface         Figure 5-6-4 Surface Points List 

- Batch: Add points in the point library in batches, select the check box before the point name 

to select all the points. 

    

Figure 5-6-5 Add Surface Point                        Figure 5-6-6 Batch 
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Figure 5-6-7 Delete or Edit 

- Edit: Edit existing surfaces. Long press the selected surface point to delete or edit it. 

- Delete: Click to delete existing surfaces. 

 

Figure 5-6-8 Surface Preview 
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- View: Select or create a new surface, and then click to view the surface preview. 

 

     

Figure 5-6-9 Check Surface Point       Figure 5-6-10 Calculation 

- Check Surface Point: Calculate the elevation of the input point. If the point is not in the plane, 

it can’t be calculated. If the point is in the plane, click OK after the check, the point will be saved 

in the stakeout point library and the description will be the checkpoint. 

- Import: Click to import the surface file in the Surface File( *.ttin) format. 

- Export: Click to export the surface file in the CASS Format (*.sjw) format. 

 

5.7 Elevation Difference 

This function is to do the DTM surface stakeout, and calculate the elevation difference between 

the current point and the fitted point of the selected surface. 

Click Stake Surface Lib to choose the surface to stake out, then it will display the TIN grid 

information in real-time. The Fill value will be displayed on the top left, and the coordinates and 
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detailed height will be displayed on the bottom slide bar. 

 

     

Figure 5-7-1 Elevation Difference            Figure 5-7-2 Select the Surface 

- : Click to enter the surface library interface to add or load the surface, and edit the surface 

information. 

 

 

 

 

 

 

 

                                        

                                           Figure 5-7-3 Surface Library 
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5.8 Surveying Configure 

The surveying configuration is a common menu that is used to configure the graphical display 

of the work interface, including the road and general survey configuration of the Detail Survey, 

Stake Points, Stake Line, Stake Road, Store Cross-section and Road Design. 

    

Figure 5-8-1 Surveying Configure               Figure 5-8-2 Configure 

5.8.1 Display 

The display configuration contains the Road Survey Config and General Survey Config. 

Road Survey Config: Cross-section Point and Roadline Transition Point. 

General Survey Config: Coord Poinft, Stake Point, Control Point, Stake Line Lib, Voice Prompts, 

Optimize Scale, Centered Display GPS, Keep GPS Centering, Display Name, Electronic Bubble, 

Real-time Mileage, Dis to last Coord Pt, Fix Direction, Controller Dir, Display Colorand Online 

Map. 
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Figure 5-8-3 Display(1)               5-8-4 Display(2)                      5-8-5 Display(3) 

- Cross-section Point: Select whether to display the point name of the cross-section point during 

the road collection. 

- Roadline Transition Point: Choose whether to display line feature points in the measurement 

interface during the road collection. 

- Coord Point: Choose whether to display the coordinate point name. 

- Stake Point: Choose whether to display the stake point name. 

- Control Point: Choose whether to display the control point name. 

- Stake Line Lib: Choose whether to display the stake line library. 

- Voice Prompts: Choose whether to open the voice prompts. Users can record user-defined voice 

prompts in the *.wav format: the file storage path is ZHD/Sounds. Customized file names have 

prescribed formats, including fixed.wav, losefix.wav, savedone.wav, stakereminder.wav and 

stakedone.wav. 
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5-8-6 Voice Files Path 

- Optimize Scale: Choose whether to automatically adjust the scale to the right size. When 

enabled, it will automatically adjust the screen display based on the coordinate range in the 

coordinate data, and the Centered Display GPS and Keep GPS Centering will be invalid. 

- Centered Display GPS: When the current point is not in the screen display range, the current 

point will be automatically centered. 

- Keep GPS Centering: The current point is always in the middle of the screen. 

- Display Name: Choose whether to display the point name. 

- Electronic Bubble: Choose whether to display the electronic bubble. When it’s not displayed, 

the inclination won’t participate in the acquisition accuracy judgment. 

- Real-time Mileage: Select whether to display the current real-time mileage value in the Stake 

Line and Stake Road interface. 

- Dis to last Coord Pt: Select whether to display the distance to the last point. 
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- Fix Direction: Smooth the sample over a period of time, and the calculated direction value will 

be relatively stable to reduce the irregular beats in direction. 

- Controller Dir: After selecting, click OK as prompted to keep the hand-held controller screen 

upward, and move the hand-held controller according to the prompt to complete the calibration. 

Then return to the survey interface; the direction of the current point will be the direction of the 

hand-held controller. 

 

5-8-7 Controller Dir Prompt 

- Display Color: Select whether the map is displayed in the feature color. 

- Online Map: Select Google maps as the basemap to survey or stake out. Make sure the network 

is connected and it has updated to the latest Google service. 
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5.8.2 Data 

The data configuration contains the Road Survey Config and General Survey Config. 

Road Survey Config: Cross-section Precision, the default value is 0.0500m. 

General Survey Config: Required Solution, Working Area, Physical Record Button, Point Info 

Dialog, Auto Start Average, Auto Store After Average, Store Average Points, Allow Same 

PtName, Tilt Survey, Bubble Precision (<2.0000), HRMS Tolerance, VRMS Tolerance, Stake 

Tolerance, Stake Prompt in, Mileage Tolerance, PtName Increasing by and No Fixed Prompt 

in(s). 

     

Figure 5-8-8 Data(1)                5-8-9 Data(2)                          5-8-10 Data(3) 

- Required Solution: Limit the solution type, including the Auto, SDGPS, DGPS, Float and Fix. 

When the solution type is limited to the Fix, the accuracy prompt box will not pop up if the 

solution is acquired in the fixed solution state. 

- Working Area: Users can draw the range of the survey area and select over range tips. 
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5-8-11 Survey Area 

- Physical Record Button: Set the acquisition key  on the physical keyboard as the Single 

Record or Average Record shortcut key. 

- Point Info Dialog: Choose whether to display the point information confirmation box after 

collection. 

- Auto Start Average: Check this option and click the average button, to enter the average 

collection interface, to automatically start smoothing. If this option is not checked, the smoothing 

won’t start automatically, users need to click the start button in the average collection interface 

to start. 

- Auto Store After Average: After it’s turned on, click OK to do the average collection. When 

the number of smoothing reaches the set number, it will automatically exit the average interface 

and save points. User can also click OK to end average collection in advance. 

- Store Average Points: Choose whether to save average data automatically. 
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- Allow Same PtName: Choose whether users can collect points with the same name. 

 

- Tilt Survey: Tilt survey can be done after turning on, and there will be tilt correction during 

data processing to get coordinates of points to be measured (only for specific models, and users 

can only start the tilt correction after completing calibration steps). 

- Bubble Precision (<2.0000): Set the electronic bubble acquisition accuracy. The acceptable 

range of tilt distance when acquiring coordinates is recommended to be within 30 degrees. 

- HRMS Tolerance: The horizontal RMSE of points, users can enter the maximum RMSE limit. 

When collecting points, there will be a prompt if it exceeds the limit value. 

- VRMS Tolerance: The vertical RMSE of points; users can enter the maximum RMSE limit. 

When collecting points, there will be a prompt if it exceeds the limit value. 

- Stake Tolerance: The precision limitation of stakeout points. Within the limit, the software will 

indicate that it has reached the accuracy range of the stakeout. If the sound prompt is enabled, an 

audio prompt will be given. 

- Stake Prompt in: Set the prompt range of the stakeout. When the stakeout point is within the 

range, the range line will change colour. If the sound prompt is enabled, an audio prompt will be 

given. 

- Mileage Tolerance: Set the maximum error limit for real-time mileage. 

- PtName Increasing by: The accumulation number value of the point name suffix. The default 

value is 1. 

- No Fixed Prompt in (s) : Voice prompt interval when the fixed solution is reached. The default 

value is 60s. 
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Notice:  

The default value of data acquisition accuracy of the fixed solution in the 

software is the value (m) shown in the figure below: 

 

5-8-12 Default Values 

 

5.8.3 Stake 

The stake configuration contains the Road Survey Config and General Survey Config. 

Road Survey Config: Real-time Mileage HT Diff. 

General Survey Config: Stake Guide Type, Reference Direction, Stake Order, Show Offset on 

Map, Check Move Direction, Map North Direction, Repeat Stake, StkName as PtName, Named 

by Station, Named by Real-time Station, Save Mileage and Save Real-time Mileage. 
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Figure 5-8-13 Stake(1)                    Figure 5-8-14 Stake(2) 

- Real-time Mileage HT Diff: After turning on, the height difference in the information bar of 

the Stake Road interface is the height difference between the current point projection on the line 

and the current point (make sure there is a road profile). 

- Stake Guide Type: Select the stake guide type, including Front-Back and North-South.  

 

Figure 5-8-15 Stakeout Prompts 

 

○1  

○2  

○3  
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- Reference Direction: Select the reference direction, including the Sun Azimuth, Base Azimuth 

and Custom Azimuth. 

- Stake Order: Select stakeout points with ascending or descending order. 

- Show Offset on Map: When turned on, the stakeout prompt will be displayed on the map during 

the point stakeout process. If the Check Move Direction is turned on at the same time, and the 

distance from the current point to the stakeout point is greater than the stakeout distance, the 

horizontal distance from the current point to the stakeout point will be displayed; otherwise, the 

front-back or south-north prompt will be displayed. 

- Check Move Direction: After turning on, when the distance from the current point to the 

stakeout point is not within the range of the stakeout distance, a large arrow will be displayed to 

indicate the deflection angle between the moving direction and the direction from current point 

to the stakeout point. If it’s approaching the stakeout point, it will be displayed in green. If it’s 

moving away from the stakeout point, it will be displayed in red. If the moving direction is almost 

perpendicular to the direction from current point to the stakeout point, it will be displayed in 

yellow. 

 

 

 ○1 In the Front-Back mode, the upward arrow indicates forward, and the downward 

arrow indicates backward. In the North-South mode, the upward arrow indicates the 

north, and the downward arrow indicates the south. 
 ○2 In the Front-Back mode, the left arrow indicates left, and the right arrow indicates 

right. In the North-South mode, the left arrow indicates the west, and the right arrow 

indicates the east. 
 ○3  In both modes, it indicates the height difference. 
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Figure 5-8-16 Approaching                 Figure 5-8-17 Moving Away 

- Map North Direction: Select the map direction, including the Map North or Forward. 

- Repeat Stake: When turned on, it supports the repeat stake. Users can choose whether to skip 

the collected stakeout points automatically. 

- StkName as PtName: Select whether to set the stakeout point name as the default point name. 

- Named by Station: Select whether to set the station as the default point name. 

- Named by Real-time Station: Select whether to set the real-time station as the default point 

name. This option can’t be opened simultaneously with the Named by Station. 

 

Notice:  

When turning on the Named by Station or Named by Real-time Station option, 

users need to select the Allow Same PtName option in the Configure→Data 

interface. 

- Save Mileage: When collecting points, the mileage will be automatically filled as the  

stakeout point mileage. 
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- Save Real-time Mileage: When collecting points, the mileage will be automatically filled as the 

real-time projection mileage (the Save Mileage and Save Real-time Mileage must and can only 

be selected one at a time).  
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COGO 

This chapter contains:  

 

■ Angle Conversion 

■ Distance Conversion 

■ Coordinate Conversion 

■ Area Calculation 

■ Distance and Azimuth 

■ Intersection Measurement 

■ Angle Calculation 

■ DTM Volume Calculation 

■ Calculator 

 
C H A P T E R  
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6.1 Angle Conversion 

Support Radian, Degree, DMS, Gon, Mil angle units transforming mutually. After you input a 

value to any item, click Compute: another several values will be calculated. 

 

Figure 6-1-1 Angle Conversion 

 

6.2 Distance Conversion 

 

Figure 6-2-1 Distance Conversion 
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Support km, m, cm, mile, nautical mile, yard, foot, inch distance units transforming mutually. 

After inputting a value to any item, click Compute: another several values will be calculated. 

 

6.3 Coordinate Conversion 

The data includes source ellipsoid and local ellipsoid. After inputting point information, you can 

switch between BLH, XYZ or NEZ. Click To Local or To Source to complete conversion 

between source ellipsoid and local ellipsoid. The coordinate of point can be selected from real-

time collection, coordinate library or map. 

   

Figure 6-3-1 Coordinate Conversion     Figure 6-3-2 Receiver Collection 
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Figure 6-3-3 Point Library Selection   Figure 6-3-4 Select Point from Map 

 

6.4 Area Calculation 

Used for calculating area, circumference and some other parameters of graph. Area is indicated 

by sq.m or mu and circumference is indicated by m. The coordinate of point participated in 

calculation can be added manually, or real-time collected from the receiver, or selected from a 

coordinate library or map. 

 

                        Notice:  

In the Map interface of Area, the Select Point  is not the same as the Map 

selection  in the List interface of Area. In the former, the points on the map 

are selected by clicking on the point, and the latter by the way of selecting points 

in the circle and selecting the node on line. 
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The difference of map selection between Area and the other interface is: click  to enter map 

selection mode. Frame select point on the map when the icon is in the state  , when frame 

select multiple points, press  but only one point in the box can be selected, click  again to 

exit the map selection mode; Among them, when the icon is in the status  , you can select 

multiple points in the box, click  or  again to exit the map selection mode, click OK to 

complete. Return to the list to view the selected points. 

 

Figure 6-4-1 Area Calculation 
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Figure 6-4-2 Select Point          Figure 6-4-3 Multiple Select 

- Add: The points can be added to list by the way of real time collection, point library and graph 

selection. 

- Compute: Calculates the area, mu, and length of the current point in order, and can view 

graphics and calculations in the result interface. 

 

6.5 Distance and Azimuth 

Used for calculating distance and azimuth between two points. The coordinate of A and B points 

can be manually input, or read from receiver, coordinate library or map. After reading 

successfully, click Compute to calculate Azimuth, Bank Angle, 2D-Distance, 3D-Distance and 

H-Distance. 
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    Figure 6-5-1 Distance and Azimuth                 Figure 6-5-2 Result 

 

6.6 Intersection Measurement 

In the case of a point needing measurement, but observation conditions are not ideal, calculate 

the needed point coordinate by measuring a nearby point. Click every icon to enter the 

corresponding measurement mode. The software supports six measurement modes (4Pt, 2Pt2L, 

2Pt1L, 2Pt2A, 2Pt1A1L, Azimuth). 
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Figure 6-6-1 4Pt Interface             Figure 6-6-2 2Pt2L Interface 

    

Figure 6-6-3 2Pt1L Interface               Figure 6-6-4 2Pt2A Interface 
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Figure 6-6-5 2Pt1A1L Interface           Figure 6-6-6 Azimuth Interface 

There are two positions of P according to the theory of 2Pt2L; 2Pt2A, 2Pt1A1L. If you input the 

coordinate of A first and then the coordinates of B, the position of P will be located above the 

AB line. Conversely, if you input the coordinate of B first, the position of P will be located under 

the AB line. 

In the above intersection measurement methods, select known point ID, input the coordinate of 

the intersection measurement point (manual input, or read from receiver, coordinate library, map), 

input other known keys (such as: L1, L2, etc.), click Compute, calculate the coordinate of 

unknown point P, click Save, input name, description and so on to save into the coordinate library. 

In the Intersection, when you click GPS collection, prompting precision information (accuracy 

setting is performed in the Configuration) is easy for understanding of real-time accuracy. 
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6.7 Angle Calculation 

Used for calculating the angle of the three-point line. 

   

Figure 6-7-1 Angle Calculation    Figure 6-7-2 Interior and Exterior 
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6.8 DTM Volume Calculation 

    

Figure 6-8-1 COGO interface    Figure 6-8-2 Volume interface 

 

Calculate the volume, 2D perimeter, 3D perimeter, and DTM area of two DTM surfaces, or 

between a DTM surface and a predetermined elevation. 

- Select surface: Click extend icon  , Select an actual surface from the List Surface. 

- Input the reference elevation: Check it, the reference elevation and the surface are used for 

volume calculation. Click extend icon  , input the target height needed to fill/dig. 

- Select the reference point: Check it, the reference point and the surface are used for volume 

calculation. Click extend icon , Select a point as a reference point from the Point Library. 

- Define range: Check it, calculate the volume inside boundary; conversely, without checking it, 

it will calculate the volume in the public area. Click extend icon  , you can select the range 

points on the Define range interface, and add, edit, delete, load, and save the range points. 
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Figure 6-8-3 Checked Boundaries 

 

 

 

 

 

    

Figure 6-8-4 Define Range                    Figure 6-8-5 Boundary Point 
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- Add: Add a range point by manual input, real-time collection, point library selection or map 

selection, Define Range requires at least three points. 

- Edit: Select the range point you want to edit: you can edit the coordinates of the point. 

- Delete: Select a range point, click Delete to delete directly, no prompt. 

- Load: Load an existing boundary file (*.waa), the load path is: ZHD\ Project\ ROAD\ Project 

Name\ dtm folder. 

- Save: Save the re-add/edit volume boundary file: the save path and file format is consistent 

with that in Load. When the saved file name already exists, it cannot be saved, but check Cover 

to save modified file. Also, click OK will also save re-add / edit volume boundary file. 

  

 

 

 

 

 

 

 

 

 

 

 

Figure 6-8-6 Save Directory 

After selecting different calculation methods, click Compute and view the volume calculation, 

measurement surface, digging area, and fill area product information on the Results interface. 
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Figure 6-8-7 Two Surfaces 

 

    

Figure 6-8-8 Surface and Point   Figure 6-8-9 Surface and Elevation 
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Figure 6-8-10 Result Above     Figure 6-8-11 Result Below 

    

 

Figure 6-8-12 Elevation Result   Figure 6-8-13 Point Result 

- Area (2D: m2): The area projected onto the horizontal plane. 

- Area (3D: m2): The area projected onto the slanted reference plane. 

- Perimeter (2D: m): The length of the polygon from the start point to the current measurement 

point in surface (2D). 

- Perimeter (3D: m): The length of the polygon from the start point to the current measurement 

point in surface (3D). 
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6.9 Calculator 

Used for simple mathematical calculations. 

 

Figure 6-9-1 Calculator 
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Tilt Survey 

 

This chapter contains:  

 

■ Electronic Bubble Calibration 

■ Tilt Calibration and Verification 

■ Tilt Survey Procedure 
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7.1 Electronic Bubble Calibration 

1. Connect to the receiver with tilt survey function. In Additional Settings, click Electronic 

Bubble Calibration to enter the program. 

    

Figure 7-1-1 Additional Settings        Figure 7-1-2 Receiver Settings 

2. When the device had been perfectly levelled up, click Start for calibration, then click OK.  

 

Figure 7-1-3 Bubble Center 
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Figure 7-1-4 Warning 

3. When success is prompted, the electronic bubble and horizontal bubble of base will be 

centered at the same time. 

    

Figure 7-1-5 Calibrating             Figure 7-1-6 Calibration Success 

4. Calibration is finished. Notice: It is recommended to calibrate the device every 30 days, but 

the calibration cycle can be adjusted. 
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5. Auto collection. When the auto mode is set as Bubble Is centered the software will collect the 

points automatically when the electronic bubble is centered. 

 

Figure 7-1-7 Auto Collection 

 

Notice: When use the Bubble Is Centered for automatic collection, first set 

bubble precision. Connect a receiver with tilt measurement function, enter main 

interface → Survey → Surveying Configure → Data (or: enter survey interface 

→ click Configure at the top right corner→ Data), the Bubble Precision can set 

when tilt Survey is off. 

 

Figure 7-1-8 Tilt Survey And Bubble Precision 
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7.2 Tilt Calibration and Verification 

7.2.1 Tilt Calibration  

The whole tilt calibration has three steps: 

1. Orientation sensor calibration; 

2. Electronic bubble calibration; 

3. Magnetic calibration. 

The order of 1 and 2 steps can be reversed, but must be performed before step 3. 

 

 

Notice:  

1. The calibration should be done in a low magnetic interference area or an open 

field. Don’t do calibration on the roof or top of a high building. 

 

2. Calibration should be done in external station mode, don’t use the internal 

UHF link,h to avoid magnetic interference. 

3. Don’t change battery and power off during all the calibration steps. 

 

Here are the detailed operations below: 

1. Orientation Sensor Calibration 

Additional Settings → click Orientation sensor calibration to enter calibration interface. 
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Figure 7-2-1 Sensor Calibration             Figure 7-2-2 Start Calibration 

Click Start to begin calibration, the calibration of the orientation sensor needs to be calibrated 

according to the demo. 

 

    

                 Figure 7-2-3 Warning                       Figure 7-2-4 Rotate The Device 

Rotate at an average speed, approximately 7 seconds for a cycle. 
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Figure 7-2-5 Rotary Axis 

Clockwise rotate about 45 degrees, repeat step a, you need a total of 8 cycles at least. 

 

 

 

 

 
Figure 7-2-6 Clockwise Rotate 

After the calibration is completed in each direction, the second Ding-Dong sound indicates 

Success from the device, that means calibration is finished. Conversely, prompting failure -  do 

do calibration again.  

Rotary axis 
 

Rotary axis 
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Figure 7-2-7 Calibration            Figure 7-2-8 Calibration Success 

 

 

2. Electronic Bubble Calibration 

Please refer to: Electronic Bubble Calibration. 

3. Magnetic Calibration 

This step can be done only after the calibration of electronic bubble and orientation. 

Additional Settings → click Magnetic calibration to enter calibration interface. 
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Figure 7-2-9 Start Calibration 

Click Start to start calibration, magnetic calibration needs calibration in horizontal position. 

 

    

Figure 7-2-10 Warning                         Figure 7-2-11 Calibrating 

Keep the device on horizontal and rotate it clockwise a week, slowly and evenly around the 

vertical axis. Rotation speed is recommended to be less than 20 degrees per second,ith slow 

uniform rotation and no pause during rotation. 
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Figure 7-2-12 Horizontal Rotation 

 

When horizontal calibration is complete, the second Ding-Dong sound from the device indicates 

Success. Conversely, prompting failure - do calibration again.  

    

    Figure 7-2-13 Failure                        Figure 7-2-14 Successful 

7.2.2 Calibration verification 

Rotary axis 
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In order to make sure accuracy is not strongly interfered with by the environment and procedure, 

verification is necessary before starting the tilt survey.  

Put the device at 30 degree tilt approximately, on the pole, and rotate it slowly clockwise for a 

week. View the azimuth changes, if the differences between maximum and minimum values is 

less than 5 degrees, it means the sensors are working well and you can do a tilt survey directly, 

otherwise module verification will be required.  

                         Notice:  

1. The pole shouldn’t be moved.  

2. Rotation speed should be 2 degrees per second and it takes about 3 minutes to 

rotate one week. 

 

 

Figure 7-2-15 Calibration Verification 

 

Unscrew the knob and hold the 

pole to rotate device clockwise 

slowly around pole. 
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Notice:  

1. When replacing a new measurement area, or the terrain complex environment 

of the measurement area changes greatly, module verification is required before 

measurement. 

2. When the new device first uses tilt measurement, it must be calibrated. 

3. After the new battery is replaced, the device must be calibrated. 

 

 

 

7.3 Tilt Survey Procedure 

After electronic bubble calibration, orientation sensor calibration, magnetic calibration and 

verification are successful, we can do a tilt survey. If the device has not undergone calibration, 

users will be prompted when Tilt Survey is opened: you must complete all calibrations before 

you can open Tilt Survey. Tilt Survey conditions are limited to: static, within 20 degrees of tilt. 

1. Tilt Survey must be opened when we do a tilt survey, click Surveying Configure→Data→Tilt 

Survey. 

    

Figure 7-3-1 Tilt Survey           Figure 7-3-2 Slope Method 
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2. When Tilt Survey is not opened，the software will not do tilt survey, the software survey 

interface displays and records the coordinates of the tilt point to the point library. Conversely, 

when Tilt Survey is opened, the interface displays and records coordinate points to the point 

library: this coordinates point is the calculated ground coordinate point. 

3. Collect Point 

Enter survey interface to collect points, it supports two survey modes: Corner Slope and Normal 

Slope. The corner slope mode is accurate and reliable, the normal slope mode is simple to operate. 

 

Figure 7-3-3 Collection Point 

7.3.1 Corner Slope 

This mode is more precise, but it takes little a longer in the field. Orientation and magnetic 

calibration recommendation is prompted when interference is found by the device. 

1. Please keep the receiver tilted and static, then click the collection icon. The best tilt angle is 

10 degrees ~ 20 degrees: follow the prompts to operate. 
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Figure 7-3-4 Step One 

2. Tilt in the other direction, with an azimuth span angle of 30 degrees to 120 degrees (Azimuth 

Span Angle: the angle formed by the vertical projection of the pole in two directions), and keep 

it static. There will be a sound promps ‘Di’ indicating that collection is complete. 

    

               Figure 7-3-5 Step Two                      Figure 7-3-6 Step Three 

2. In the Save Point interface, you can see the tilt angle and tilt azimuth of the point. 
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Figure 7-3-7 Save Point 

7.3.2 Normal Slope 

This method is much simpler, the receiver will collect points when it is still (function available 

in firmware version after v5.1 for V90 Plus and v1.1 for iRTK5). Orientation and magnetic 

calibration recommendation is prompted when interference is found by the device. 

1. Enter process interface Raw Data → More → Process. 

       

Figure 7-3-8 Raw Data            Figure 7-3-9 More               Figure 7-3-10 Process 
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2. Data Transfer is a raw data custom export. It supports export not an increase in plane 

coordinates for tilt correction (tilt N, tilt E, tilt Z is not tilt correction of plane coordinates). Select 

the export path and input the export file name and after completing the custom format settings, 

click OK to export. 

    

Figure 7-3-11 Save Raw Data   Figure 7-3-12 Custom Format 

7.3.3 Abnormal prompt 

1. When you have finished following the prompts, if the prompt Corner Slope fail appears, the 

current point is not saved. 

 

 

 

 

 

 

 

 

 Figure 7-3-13 Prompt 
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2. When it prompts The current low precision, whether to save data, click OK to save the 

calibration ground point coordinates, click Cancel to not save the coordinate data. 

3. When the collection point prompts Magnetic is change, so it is not collecting points and you 

need to do the three steps of tilt calibration. 
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Quasi-dynamic Survey 

 

This chapter contains:  

  

■ Function Introduction 

■ Operation Procedure 

 

 

 

 

 

 
C H A P T E R  

 

 

8 

 



Quasi-kinetic Survey 

239 

 

 

 

 

8.1 Function Introduction 

Quasi Dynamic RTK Survey was invented by Hi-Target, a new way to survey in tough areas 

where there is strong multi-path interference, signal blocking like standing beside big trees; the 

reliability is much better than the normal RTK survey in those conditions. It can offer precise 

coordinates in 20 – 40 seconds, with better fixing rate, accuracy and reliability. 

 

8.2 Operation Procedure 

1. Activate the function. 

Additional Settings → Receiver Settings → Quasi Dynamic RTK → Set. 

    

Figure 8-2-1 Receiver Settings            Figure 8-2-2 Quasi dynamic RTK 

2. After the RTK correction from base receiver or CORS service had been received for more  
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than 30 seconds, the quasi dynamic RTK survey is ready to work.  

3. Go to Detail Survey interface, click  button in the screen to start. If you get the feedback 

PPK engine is under preparation, then please make sure the receiver is getting corrections. 

       

Figure 8-2-3 Button(1)          Figure 8-2-4 Button(2)           Figure 8-2-5 Prompt 

4. It should take 20 – 40 seconds to finish collection, during the procedure please keep the 

receiver as steady as possible, rotating and shaking is not allowed. 

 

Figure 8-2-6 Prompt 

5. After the dingdong sound is tweeted, the collection is done and point is saved. In this mode, 

the normal detail survey RTK point collection is still available.  
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Appendix 

 

This chapter contains:  

  

■ Technical Terms 

■ Troubleshooting 

■ File Formats 
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9.1 Technical Terms 

1. Global navigation satellite system（GNSS） 

Global navigation satellite system (GNSS), this is the standard generic term satellite navigation 

system, it provides global coverage of geographic spatial orientation, including the US GPS, 

Russian GLONASS, Chinese BDS and the European Union's Galileo. 

2. GPS time 

The time measurement used by the NAVSTAR GPS system. 

3. UTC 

Universal Time Coordinated. Time standard for local daylight hours based on Greenwich 

meridian. See GPS time. 

4. Multipath 

Interference (similar to the heavy shadow on a television screen). GNSS signals arrive at multiple 

paths before they reach the antenna through different paths. 

5. Degree of ambiguity 

The number of weeks in the carrier phase pseudo space between GNSS satellite and GNSS 

receiver. 

6. Ephemeris 

Current satellite position prediction. It is transmitted in the data. 

7. Epoch 

Measurement interval of GNSS receiver .Variation of the calendar element with measurement 

type: 
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- For real-time measurement, it is set to one second. 

- For post-processing measurements, set to one second and one minute. 

8. Antenna height 

The height of the receiver phase center to the center of the station. 

9. Reference station（base station） 

In a certain period of time, and if one or several receiver, on one or a few test sites, keep tracking 

an observation satellite, with the receiver in a certain range, the fixed station is called a reference 

station. 

10. Mobile station  

In a certain period of time, and if one or several receivers, on one or a few test sites, keep tracking 

an observation satellite, and the receiver is within a certain range, the fixed station is called a 

reference station。 

11. Single reference station RTK measurement. 

Only one base station is used, and the carrier phase difference correction parameter is measured 

by the data communication technology receiving base station. 

12. Network RTK (CORS/VRS) 

Refers to multiple reference stations in an area, network coverage to the region composition, and 

continuous tracking observation, through the sites of GPS observation network, covering the 

region and the time period for RTK correction parameters, in the region for RTK line RTK real-

time correction way of positioning. 

13. Cut-off height angle 

In order to shield the effect of occluded objects (such as buildings, trees, etc.) and the multipath 

effect, the value of the angle threshold is lower than that of the satellite in the field of view,  
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which is usually set to 10 degrees. 

14. Fixed solution 

This indicates that the ambiguity has been solved and the measurement has been initialized. It is 

the most accurate type of solution. 

15. Floating solution 

Indicates that the ambiguity has been solved and the measurement has not been initialized. 

16. DOP (dilution of precision) 

Position Dilution of Precision (Dilution of Precision) are GNSS quality marks. It takes into 

account the position of each of the satellites, relative to the other satellites in the constellation, 

and their geometric position relative to the GNSS receiver. The smaller the DOP value, the higher 

the accuracy reliability. Standards applied by GNSS DOP value are: - the PDOP - position (3d 

coordinate) - RDOP relative (position), average time - HDOP - level (two-dimensional horizontal 

coordinates) - VDOP - vertical (only height) - TDOP - time (the clock offset only). 

17. Spatial position dilution of precision (PDOP) 

A unit number that represents the relationship between user position error and satellite position 

error. The factors reflecting the attenuation of positioning accuracy are related to the spatial 

geometric distribution of the measured satellite, and the larger the spatial distribution range, the 

smaller the PDOP value and the higher the positioning accuracy; conversely, the larger the PDOP 

value, the lower the positioning accuracy. 

18. PDOP limit 

The highest PDOP value for the receiver's computed position. 

19. PPM 

The measurement of the slanting distance of one millionth is corrected for the impact of the 
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earth's atmosphere. PPM is determined by the observed pressure and temperature as  well as the 

specific instrument constants. 

20. The RMS 

The Root Mean Square is used to indicate the measurement accuracy of the point. It is the error 

circle radius at about 70% of the fixed point. 

21.SNR 

（Signal-to-Noise Ratio）。It is a measure of the strength of satellite signals. SNR ranges from 

0 (no signal) to 99, of which 99 is the best, and 0 means the satellite is not available. The typical 

good value is 40. Normally, when SNR is above 25, GNSS systems begin to use satellites. 

22. Weighted index 

The weighted index is used in the neighbourhood adjustment calculation. The calculated distance 

from each new point to the control point, in the station establishment, will be weighted according 

to the weighted index when the coordinate adjustment applied to the new point is calculated. 

23. Pile distance/station distance. 

The distance or interval along a line, arc, or path. 

24. Projection 

Projection is used to produce a plane map that represents the surface of the earth, or that part of 

the surface. 

25. The ellipsoid 

The earth's mathematical model of the rotation of an ellipse around a short axis. 

 

26. Geodetic datum 

A mathematical model designed to fit some or all of the geoid surface (physical earth surface). 
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27. Earth level 

It's very close to the universal gravitation of the sea’s surface. 

 

9.2 Troubleshooting 

1. Receiver keeps tracking but failed to give coordinates.  

Please try the possible solutions below:  

(1) Set up the receiver again in another place with much less electromagnetic wave interference 

(like a power station, radar station, etc.)  

(2) Set the working mode of the receiver to static, then collect static data for 3 – 5 min, then 

switch it back to the original mode (base or rover) 

(3) Long press function button to reset motherboard, or restart the device.  

2. Base station failed to send correction signal. 

Please try the possible solutions below: 

(1) Replace the battery in case the battery power is too low (power LED will flash red)  

(2) Abnormal LED display in base mode 

a. Satellite LED flashing, means the receiver failed to track the satellites and the coordinates 

cannot be provided: 

The place where the base was set might be blocked by buildings or shelters and the useful  

satellites were less than 4. Find a better place to set up station again.  

Coordinates provided by the base station are far from the actual coordinates; in this case a re-

averaging of base coordinates is required.  
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b. Satellite LED keeps on but signal LED does not flash: this means the base does not transmit 

the correction signal. Please reset up the base.  

(3) Central meridian might be set with a mistake, double check this parameter.  

(4) Reset motherboard, restart the device.  

3. Rover cannot receive signals even if it is very close to the external radio of the base station: 

(1) If the signal LED is not flashing, please refer to problem 2 (previous problem). 

(2) Transmitting LED RX/TX does not flash (flashes once every second in normal conditions)  

a. Check if the cable is connected firmly.  

b. Check if the cable is broken, try to replace the cable.  

c. Replace the power if the battery is too low.  

(3) Everything is alright with the base part but the rover signal LED does not flash. 

a. Make sure the radio channel and link rate are the same as the settings in base.  

b. Internal radio module in rover is abnormal, try to replace it, or grade the firmware or restart 

the device.  

(4) Rover signal LED flashed but in the software there is no common satellite number showing.  

a. Make sure the message types between base and rover are the same.  

b. Rover is severely interfered with and common satellites number is less than 4, so the number 

is not showing. In this occasion please go to an open air area to set the rover.  

4. Short range of radio communication in external radio base mode. 

These are three possible reasons: 

(1) External battery power is too low to supply enough power to transmit the signal. Replace the 

battery. 

(2) Transmission method is not set to be external radio on base station. 

(3) External radio abnormal. 
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a. Power is set too low. 

b. Transmission antenna is not installed properly. 

c. Cable is not connected firmly.  

d. Antenna on rover is not installed firmly or broken.  

(4) Strong interference in the base area. Try to change the channel or change the place to set up 

base 

5. Failed to connect to internet in internal GSM mode. 

How to solve:  

(1) Cellular internet antenna is not installed or not installed firmly. 

(2) Internet setting incorrect (check IP address, port, telecom operator, APN, CORS ID and 

password, etc.)  

(3) SIM card problems 

a. Not installed properly, or the position is not matched to the pins, either too shallow or too deep. 

b. No balance in the SIM account.  

c. Band of SIM card is not matching the band in the cellular modem. Try to use another SIM 

card from other telecom operator. 

(4) Cellular signal is weak in the region.  

(5) CORS server is not working properly. Try to use another device to test it.  

(6) Reset the device.  

6. ZHD Server connection failed. 

How to solve:  

(1) Check the IP, port, Area ID, Group ID, message type is same between base and rover.  

(2) Account or Group ID and Area ID occupied by other users. First come, first served.  

(3) Server abnormal. Please contact CORS service center for help.  
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7. Rover failed to get signal from CORS. 

How to solve:  

(1) Signal LED flashing green, but failed to connect to server: 

a. SIM card issues (no balance, SIM card slot loose, band incompatible)； 

b. CORS parameters issues (IP, port, mountpoint, account ID and password, etc.)  

c. Contact the CORS service center for help if the above are checked and are ok. 

d. Internal cellular modem problem, try to reset or restart the device. 

(2) Signal LED stays green but failed to receive correction signal.  

a. Check IP, port. 

b. Contact CORS service center for help if the things above are checked.  

(3) Signal LED is green and flashes yellow every second, but no common satellites number 

shows.  

a. Check if message type is correct 

b. Check if the GNSS signal is severely blocked or interfered.  

8. Bluetooth connection failed between controller and receiver  

How to solve： 

(1) Check if the working mode of receiver is static; if yes, switch it back to  

base or rover mode; check if 8-pin port of receiver is occupied or not. 

(2) Clear the Bluetooth search result list, search again and connect the device.  

(3) Either switch off and switch on the Bluetooth function, or restart the device or controller.  

(4) Update the firmware of controller, or the firmware of receiver.  

9. Android controller cannot connect to PC (windows). 

How to solve: 
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(1) Check if the driver was successfully installed or windows updated to the latest version. 

(2) Check if the anti-virus software blocks the connection due to its security. 

(3) Check if the “USB debug” function is activated. 

(4) Check the USB cable is not broken. 

10. Big coordinates difference after the Localisation work (coordinate system parameters 

calculated)  

Possible reasons: 

(1) Accuracy is not good during the data sampling in control point survey. 

(2) Control point is not distributed properly in the restion③Abnormal control point coordinates. 

How to solve: 

(1) Check the parameters result, if the scale is far from 1, then the control points might not be 

correctly input.  

(2) Check the distribution of the control points, they should not be so close to each other.  

(3) Try to delete the points whose RMS are bigger, if there are more than 3 control points. 
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9.3 File Formats 

9.3.1 Road file 

[*. Dam] : parameter file. 

[*.prj] : engineering documents. 

[*.raw] : raw database file. 

[maincst.cst] : cross-section point library file. 

[*.mcp] : the graph root data file. 

[*.bak] : the backup file will be automatically generated by the new project software if there is 

no external SD card. 

[ParamComputer] : apply the dot to the file. 

[*.rsp] : PPK time file. 

[*.ppk] : PPK post-processing file. 

[*.txt] : custom TXT file. 

[*.csv] : custom CSV file. 

[*.dxf] : DXF file. 

[*.shp] : SHP file. 

[*.csv] : Excel file. 

[*.dat] : Cass7.0, Scsg2000, and PREGEO data files. 

[*.stl] : Hi-RTK record point library file. 

[*.line] : line library file. 

[*.sec] : line meta files. 
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[*.PHI] : intersection file. 

[*.xy] : iron courtyard. 

[*.csv] : five pile files. 

[*.icd] : Elcad format. 

[*.zline] : coordinate method file. 

[*.pvi] : change the slope point file. 

[*.tpl] : cross section design line file. 

 

9.3.2 File format specification 

1. Intersection of road plane design line [*.PHI] 

PHI: Point of Horizontal Intersection. 

PHI file is stored in a text format, separated by a comma, and the first line is the format 

description [when the program reads it], starting from the second line, and a behaviour of the 

internode information; the storage format is: 

Intersection number, coordinate N, coordinate E, starting range, curve radius, forward detente 

curve, then detente curve 

※The sample: 

Intersection number, coordinate N, coordinate E, starting range, curve radius, forward detente 

curve, and then detente curve. 

1, 3361410.701, 524798.9388, 200000, 0, 0, 0 

2, 3361729.719, 516179.2477, 207750.218, 7000, 400, 400 

3, 3362156.214, 514352.2852, 209804.108, 7000, 400, 400 
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4, 3363142.054, 511810.6419, 212590.856, 7000, 400, 400 

5, 3365587.828, 502113.9878, 222784.866, 10000, 270, 270 

2. Road plane line element file. [*.Sec] 

Sec: short for Section. 

Sec files are stored in text format, separated by commas. 

The first line is: the starting information format specification [skip] when the program is read. 

The second line is: the starting point of the line, including the starting point, starting distance, 

and starting point angle. 

The third line is the line element format specification. 

The fourth line is: the beginning line is a line element information. 

Its storage format is: type, starting radius, end radius, line element length, deflection direction. 

Note: *. Type: straight line, arc, detente curve 

*. Radius: -1 represents infinity. 

*. Deflection direction: left L; Turn right R 

※The sample: 

X0, Y0, S0, Azi0 

3829469.058, 494798.067, 0, 1.67595677755068 

[Type{L, A, S}, R1, R2{-1=infinity}, Length, Direction{L，R}] 

L, -1, -1, 334.315, L 

S, -1, 300, 145, R 

A, 300, 300, 60, R 

S, 300, 90, 60, R 
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A, 90, 90, 75, R 

3. Road longitudinal section changes the slope point file [*.PVI] 

PVI: short for Point of Vertical Intersection. 

PVI files are stored in text format, separated by commas. 

The first line is the format specification [skip] when the program is read. 

From the second row, the row is a slope point information; its storage format is: 

The slope of the slope is S, the elevation of the slope is H, the first slope is higher than i1, the 

second slope is i2, and the circle radius is R. 

※The sample 

S, H, i1, i2, R 

19653.349, 794.963, 0, 0.049, 0 

20070, 815.379, 0.049, 0.007, 12000 

22180, 830.155, 0.007, -0.025, 30000 

23880, 787.655, -0.025, -0.014, 17000 

23974.007, 786.339, -0.014, 0, 0 

4. Road cross section design line document [*.tpl] 

TPL: short for Template. 

The TPL files are stored in text format, separated by commas. 

The first line is the format specification [skip] when the program is read. 

Second behaviour left design line. 

Third behaviour right design line. 

Its storage format is: the left design line [distance, slope ratio]\r right design line [distance, slope 
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ratio]. 

※The sample: 

Left design line [distance, slope ratio]\r right design line [distance, slope ratio] 

10, -0.1, 1, 0, 10, 1, 1, 0, 10, 1 

10, -0.1, 1, 0, 10, 1, 1, 0, 10, 1 

The cross-section point library (*.cst) can be opened directly with notepad, and the coordinate 

points of data exchange module can be exported *.csv, sample points, control points can be 

exported or imported *.txt format, which facilitates data exchange with the computer. 

(1) Export Excel file (*.csv) 

Roll call, N, E, Z, describe information 

4, 20.9919, 7.8963, -0.0147, Test 

(2) Sample library import/export Txt file (*.txt) 

Roll call, N, E, Z, description, set point range, whether it has been lifted (0: no, 1: yes) 

1, 2542604.5095, 434458.4638, 47.5900, Lk pile 1, 10.0000, 0 

22, 2542604.5062, 434458.4614, 45.4771, Street lamp, 30.0000, 1 

(3) Control point library import/export Txt file. (*.txt)   

Roll call, N, E, Z, description, coordinate type（0:blh，1:xyh）, B, L, H 

t, 2542604.2867, 434459.2702, 47.9231, control points A, 1, 22:58:52.51358, 113:21:38.93873, 

47.9231 

uu, 2542604.5062, 434458.4614, 45.4771, Test, 1, 22:58:52.5206, 113:21:38.91030, 45.4771 

(4) Cross section point library format（*.cst） 
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CrossSec points[Ver:1] 

E, N roll call, north coordinates, east coordinates, elevation plane Z, WGS84 latitude raw 

measurement data, B WGS84 longitude L raw measurement data, WGS84 raw measurement 

data height H, high target, high target type, the antenna type [manufacturer:type], north 

coordinate RMS values, East coordinates the RMS value, surface elevation RMS value, type, 

number of smooth, recording time, satellite altitude Angle, visible satellite number, Shared 

satellite number, PDOP value difference ages, setover, mileage (cross-sectional defined mileage), 

by collecting the real-time mileage by inverse calculation of coordinate, defined when mileage 

in the section of the pile point collection N coordinates, acquisition defined when mileage in the 

section of the pile point coordinates, E acquisition defined when the tangent of the transverse 

section is in the center of the road. 

pt0, 321.83562359172527, 75.99595486273756, -0.7214999980390115, 00:00:10.445790N, 

109:30:49.422520E, 0.0, 0.6096000000000044, 0, Hi-Target:V30, 0.014002636, 0.011343374, 

0.016180737, Single point positioning, 1, 2013-10-08 15:07:16, 0, 19, 0, 1.7887421, 1.0, 

6.263659450178594E-5, 30.0, 31.30462646484375, 321.0, 75.0, 0.8726646259971647. 


